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Develop a Mobile Workflow Package

Sybase® Mobile Workflow Forms Editor lets you create or modify Mobile Workflow
packages on different device platforms without native device development.

Mobile Workflows support the occasionally connected user and addresses the replication and
synchronization issues those users present for the back-end system.

A Mobile Workflow application requires an integration module on the server side, which is
implemented by a static set of logic that processes Mobile Workflow-specific metadata to map
keys to and from mobile business object attributes, personalization keys, and parameters. This
integration module processes the notifications identified by matching rules configured for the
server-initiated starting point and also processes the responses sent to the server from the
device.

The Mobile Workflow Forms Editor allows you to create the forms that can be assigned to the
devices that have the Sybase Mobile Workflow container installed and that are registered with
Unwired Server through Sybase Control Center.

When you use the Mobile Workflow Forms Editor, the data source for the application is
supplied by mobile business objects that are designated as message-based synchronization
mobile business objects when deployed to the server. The Mobile Workflow Forms Editor
allows you to develop mobile workflow screens that can call the create, update, delete, and
other operations, as well as object queries of a mobile business object.

You can generate a Mobile Workflow form that works on these platforms:

• Apple iOS
• Android
• BlackBerry
• Windows Mobile

See the Sybase Unwired Platform Installation Guide for supported version levels.

When designing the user interface for Mobile Workflow forms for mobile devices, keep it
simple. The Mobile Workflow form should deliver clear, concise content with minimal
navigation menus. The Mobile Workflow should be compatible with a wide variety of devices,
and support both horizontal and vertical screen layouts. Consider the limitations of mobile
devices when designing a Mobile Workflow form.

Develop a Mobile Workflow Package
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The Mobile Workflow Forms Editor

The Mobile Workflow Forms Editor allows you to create the forms that can be assigned to the
devices that have the Sybase Mobile Workflow application installed and that are registered in
Sybase Control Center.

The Mobile Workflow Forms Editor contains these pages:

Introduction

Create a new mobile workflow or double-click an existing one, to open the Introduction page
of the Mobile Workflow Forms Editor. This page is the starting point for designing your
mobile workflow form. You can access help from this page.

Flow Design

The Flow Design page displays an empty canvas if you did not choose any of starting points in
the New Mobile Workflow Forms Editor. If you selected a starting point when creating the
new mobile workflow form, the selected starting point appears.

Use this page to specify how starting points and screens link together. The Palette view on the
right shows available starting points, screens, and connections. You can drag and drop items
from the Palette to the canvas. Screens and starting points that you drag to the Flow Design
canvas appear as icons. Double-click a screen to open the Screen Design page.

Right-click anywhere in the Flow Design page to open a context menu.

Screen Design

Use this page to design the screen of your mobile workflow form. The Palette view shows the
menu items and controls you can use to design a new screen. Drag controls to design the user
interface.

Setting Mobile Workflow Forms Editor Preferences
Use the Preferences dialog to set the appearance and device preferences for the Mobile
Workflow Forms Editor.

1. Select Window > Preferences.

2. In the Preferences dialog, select Sybase, Inc. > Mobile Development > Mobile
Workflow Forms Editor.

3. Select Flow Design Page to set the preferences for the Flow Design page.

4. Select Screen Design Page to set the preferences for the Screen Design page.

5. Click Apply.

The Mobile Workflow Forms Editor
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6. Click OK.

See also
• Creating a New Mobile Workflow Form on page 5

• Starting Points on page 8

• Flow Design Page Properties on page 20

• Flow Design Palette Options on page 24

• Screen Design Page Properties on page 28

• Screen Design Palette Options on page 30

• Mobile Workflow Forms Editor Context Menus on page 34

Mobile Workflow Forms Editor Preferences
Use the Preferences dialog to set the preferences for the Flow Design and Screen Design
pages.

The Mobile Workflow Forms Editor supports two different types of look-and-feel. Select
either:

• Optimize for performance – provides a more basic look-and-feel, which allows better
performance. This means that raw HTML controls are used to the extent possible (for
example, there is no signature or slider control in HTML), with little to no CSS stylization
and JavaScript enhancements to customize the look-and-feel.

• Optimize for appearance – provides a more sophisticated, or native, look-and-feel but may
affect performance.

Note: This option is not available on Windows Mobile platforms.

Preference settings determine the default behavior and style for the Flow Design and Screen
Design pages and their objects. You can change the style and behavior of objects individually
in the Properties view for a selected object. You can set these preferences for the Flow Design
and Screen Design pages:

Preference Description

Appearance Set the color and font preferences for the design-
er.

The Mobile Workflow Forms Editor
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Preference Description

Connections When a new connection is created, it follows the
default style defined in the preferences settings.
You can change the style of the connection line
individually in the Flow Design Properties view.

Select the default line style for new connections:

• Oblique (default) – the connection lines are
not aligned with the horizontal or vertical axis
and you can create break points anywhere on
the connection line. If you drag the connec-
tion line, a new breakpoint is created at the
drag point and two lines are created.

• Rectilinear – the connection line always re-
mains either horizontal or vertical.

Printing Set the general printing preferences.

Rulers and Grid Set the preferences for the ruler and grids:

• Ruler options:

• Show rulers for new diagram

• Ruler units

• Grid options:

• Show grid for new diagrams

• Snap to grid for new diagrams – select if
you want objects in the diagram to stick to
grid lines when they are being moved.

• Snap to shapes for new diagrams

• Grid spacing (in inches)

Creating a New Mobile Workflow Form
Access the Sybase Mobile Workflow Forms Editor.

Prerequisites
You must have an existing project in which to create the mobile workflow form.

The Mobile Workflow Forms Editor
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Task

1. In the Mobile Development perspective, select File > New > Mobile Workflow Forms
Editor.

2. Follow the instructions in the New Mobile Workflow Forms Editor wizard:

Field Description

Enter or select the parent folder Select the mobile application project in which
to create the mobile workflow form.

File name Enter a name for the mobile workflow form.
The extension for mobile workflow forms
is .xbw.

Advanced Link the mobile workflow form to an existing
file in the file system.

Link to file in the file system Click Browse to locate the file to which to link
the mobile workflow form. Linked resources
are files or folders that are stored in the file
system outside of the project's location. If you
link a resource to an editor, when you select the
editor, the resource is selected in the Work-
Space Navigator. Conversely, when you select
the resource in the WorkSpace Navigator, the
editor is selected.

Click Variables to define a new path variable.
Path variables specify locations on the file sys-
tem.

3. Click Next.

4. In the Starting Points page, select the ways the mobile workflow application will start:

• Can be started, on demand, from the client – creates a Client-initiated starting point.
This allows the user to start the mobile workflow on the device and submit data to the
server.

• Responds to server-driven notifications – creates a Server-initiated starting point.
When a notification that matches the defined matching rules arrives in the Notification
Mailbox, it is then sent as a notification to the devices that match those matching rules.
When you select this option, you will set up the server-initiated starting point in the
next screens of the wizard. Follow the procedure for Creating a Server-initiated
Starting Point.

• Has setup options that need to be set when the client application is first activated –
creates an Activate starting point so that the first time the workflow is launched, the
screen pointed to by the Activation screen is shown.

The Mobile Workflow Forms Editor
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• Credentials (authentication) may be requested dynamically from the client
application – creates a Credential Request starting point with pre-defined username
and password keys.

5. (Optional) If you selected the Responds to server-driven e-mail notifications option in
the previous step, follow the procedure in Creating a Server-initiated Starting Point.

6. Click Finish.

7. In the Mobile Workflow Forms Editor, click Flow Design to start designing the mobile
workflow form.

See also
• Setting Mobile Workflow Forms Editor Preferences on page 3

• Starting Points on page 8

• Flow Design Page Properties on page 20

• Flow Design Palette Options on page 24

• Screen Design Page Properties on page 28

• Screen Design Palette Options on page 30

• Mobile Workflow Forms Editor Context Menus on page 34

Creating Screens Automatically by Dragging and Dropping a Data
Source

Drag and drop a data source, for example a mobile business object (MBO) or operation onto
the Flow Design page to create screens, controls, keys, menus, and navigations automatically.

Note: Mobile business objects used as the data source must be contained in a deployed mobile
application package that is identified as "messaging."

When you use an MBO operation, a screen is created with a menu item that invokes that
operation. Controls bound to keys that are bound to that operation’s parameters are also
created.

When you use an MBO as the data source, screens and keys for the operations are created,
along with a details screen for the MBO itself, and also screens for any related MBOs and their
operations.

1. From the Flow Design page palette, select a starting point and click on the Flow Design
page.

2. From WorkSpace Navigator, expand the project that contains the data source you want to
use.

3. Select the data source, for example, a mobile business object, and drag and drop it onto the
Flow Design page.

If the mobile business object you are using as the data source has relationships with other
mobile business objects defined, all of the screens and connections between screens for the

The Mobile Workflow Forms Editor
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initial mobile business object and its relationships are automatically created. You can
change the order of the screens and create your own connections manually.

Note: Structured mobile business objects and complex parameters are not supported in
mobile workflow forms.

Starting Points
Starting points specify which screen on the Mobile Workflow a user sees when they perform a
certain action.

Starting points include:

• Client-initiated – this starting point is activated when the user opens the mobile workflow
on the device.

• Activate – this is the starting point that is activated when the user first opens the mobile
workflow application. It does not activate on the second and subsequent times the mobile
workflow application is started. Multiple workflow applications can share the same
Activate starting point. Different workflows can specify an activation key, and workflows
with the same activation key share their activation status. For example, if Workflow A and
Workflow B both specify an activation key of AB (via the key attribute on the
RequiresActivation tag), when Workflow A gets activated, it also activates Workflow B
such that when Workflow B is invoked for the very first time, its activation screen will not
be displayed.

Note: A mobile workflow application with an Activate starting point is considered to be
successfully activated only if it is closed with a Submit Workflow menu item.

• Credential request – this starting point is activated when the mobile workflow application
requires a user name and password and the program does not have one in its cache, or the
values in the cache are no longer valid.

• Server-initiated – this starting point is activated when a notification message is sent to the
device that matches the matching rules specified in the mobile workflow application.

Each starting point has a list of keys with which it is associated. View the keys associated with
the starting point in the Properties view for the starting point.

See also
• Setting Mobile Workflow Forms Editor Preferences on page 3
• Creating a New Mobile Workflow Form on page 5
• Flow Design Page Properties on page 20
• Flow Design Palette Options on page 24
• Screen Design Page Properties on page 28
• Screen Design Palette Options on page 30
• Mobile Workflow Forms Editor Context Menus on page 34

The Mobile Workflow Forms Editor
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Adding a Starting Point Manually
Every screen must be part of a flow that connects to a starting point.

Note: If you manually create a server-initiated starting point that invokes an object query, the
list key will not have any children. To create the children for the list key, you can use the New
Mobile Workflow Forms creation wizard to create the server-initiated starting point, or you
can drag and drop the mobile business object onto the Flow Design page. Either of these two
methods will create the associated children key for a server-initiated starting point that invokes
an object query. Otherwise, you will have to manually set up the list key's children.

1. From the palette on the Flow Design page, select a starting point, then click on the Flow
Design canvas.

2. Add a screen to the starting point by either:

• Dragging and dropping a data source, for example, a mobile business object or mobile
business object operation, onto the Flow Design canvas, or

• Selecting an empty screen from the Flow Design palette, then clicking on the Flow
Design page.

3. Add a connection between the starting point and the screen.

4. Select File > Save.

You can also automatically create starting points based on selections you make in the New
Mobile Workflow Form wizard when you create a new Mobile Workflow form.

Creating a Server-initiated Starting Point
Create a server-initiated starting point.

Note: Each Mobile Workflow Form package can have only one server-initiated starting point.

1. In the Mobile Development perspective, select File > New > Mobile Workflow Forms
Editor.

2. Follow the instructions in the New Mobile Workflow Forms Editor wizard:

Field Description

Enter or select the parent folder Select the mobile application project in which
to create the mobile workflow form.

File name Enter a name for the mobile workflow form.
The extension for mobile workflow forms
is .xbw.

Advanced Link the mobile workflow form to an existing
file in the file system.

The Mobile Workflow Forms Editor
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Field Description

Link to file in the file system Click Browse to locate the file to which to link
the mobile workflow form. Linked resources
are files or folders that are stored in the file
system outside of the project's location. If you
link a resource to an editor, when you select the
editor, the resource is selected in the Work-
Space Navigator. Conversely, when you select
the resource in the WorkSpace Navigator, the
editor is selected.

Click Variables to define a new path variable.
Path variables specify locations on the file sys-
tem.

3. Click Next.

4. In the Starting Points page, select Responds to server-driven notifications.

5. In the E-mail Processing wizard, click Search to locate the mobile business object with
which to associate the server-initiated starting point.

6. In the Search for Mobile Business Object wizard, click Search.

7. Select the mobile business object from the list, and click OK.

8. (Optional) Select an Object query and click Next.

Note: Object queries that return result sets are not supported.

9. Enter the contents for a sample notification message, and click Next.

10. Select the text that will serve as the matching rule by right-clicking and selecting Select as
Matching Rule; then click Next.

11. From Extraction Rules, select a parameter, and specify from where the parameter
receives data in the Extraction Rule Properties.

Note: The supported syntax for the regular expression is that used by the C# Match()
methods(s) of the class System.Text.RegularExpressions.Regex.

Property Description

Field Select the field from the notification message
from which the parameter receives data, for ex-
ample, Subject. Selecting Subject indicates that
the parameter receives data from the subject
line of the notification message.

Start tag Enter or select the text for the start tag regular
expression, for example, "Approval Re-
quest\(".

The Mobile Workflow Forms Editor
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Property Description

End tag Enter or select the text for the end tag regular
expression, for example, "\)was sent".

Format Supports locale-specific parameter extraction.
For example, you can indicate that a given date
parameter will be in the form of YYYY-MM-
DD in the e-mail, and another date parameter
will be in the form of YYYY-DD-MM. This
applies to the DateTime type.

Sample notification field contents The value of the field from the sample notifi-
cation previously specified on the Specify Sam-
ple Notification page of the Notification Pro-
cessing wizard.

Value extracted from sample notification field
contents

The value the start tag and end tag matching
rules would arrive at given the sample field
value.

12. Click Finish.

Server-initiated Starting Point Properties
View and configure the server-initiated starting point properties.

General
Select the Server-initiated starting point in the Flow Design page to view and configure its
properties.

Property Description

Mobile business object The mobile business object with which the serv-
er-initiated starting point is associated.

Object query When you define an object query in the mobile
business object associated with the Mobile Work-
flow form, the object query returns the specified
instances of the mobile business object. For ex-
ample, if a travel request to Hawaii is submitted,
the object query returns an instance of that mobile
business object so the approver can review the
travel request details then modify the status and
comment fields for that mobile business object.

Object queries that return multiple instances are
supported, as well as object queries that return
only one instance.

The Mobile Workflow Forms Editor
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Property Description

Generate old value keys By default, this is selected, which means when
data is sent, there are two copies sent—one with
the key names you select at design time, and one
with the same names prefixed with "_old." The
keys you selected at design time may get updated
by the application, but the old values will not
unless this option is selected. Those "_old" value
keys may be critical when executing an update or
parent update operation at a later time. If you
unselect this option, old value keys are not gen-
erated.

Jumpstart Launch the Notification Processing wizard,
where you can compose a sample notification
message from which to specify parameter value
extraction rules and matching rules.

Extraction rules Shows the notification extraction rules for the
server-initiated starting point. Select a rule and
click Edit to change the transformation rule.

Keys
Click Keys in the left pane of the Properties view to see the keys that are associated with the
server-initiated starting point.

Property Description

Key name The name of the associated key.

Type The type of the associated key, for example,
string.

The Mobile Workflow Forms Editor
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Property Description

Data binding Shows the data source to which the key is bound:

• Mobile business object attribute

• Mobile business object relationship

• MBO object query results

If you select an object query that returns mul-
tiple MBO instances, you can bind the result
set to a Listview control using a key that is of
the list type.

• User-defined

• Extraction rule

If you create a server-initiated starting point
that invokes an object query with a parameter,
this value is extracted from the email message
automatically.

Click New to create a new key.

Select any key and click Edit to edit the infor-
mation for an existing key.

Select a key and click Remove to remove an ex-
isting key.

Parameter Mapping
Use the Parameter Mapping section to bind the parameters (if any) of an operation or object
query to keys or, context data, such as DeviceName, BackEndPassword, BackEndUser, and so
on.

Personalization Key Mappings
If you have a mobile business object with load parameters mapped to transient personalization
keys, you can specify values for those personalization keys when you invoke an operation or
object query from the Mobile Workflow package. This can, for example, be useful for loading
only specific data into the consolidated database from large data sources.

Notification Extraction Rules
Notification extractions rules are used to extract parameter values to keys, so you can then map
the parameters to objects, such as keys.

This means that you can extract values from the notification without needing to use them right
away as parameter values. You can instead bind them to controls and display them to the user,
or use them later on in the workflow to submit a create/read/update/delete (CRUD) operation
or object query.

The Mobile Workflow Forms Editor
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Notification extraction rules include a regular expression that determines from where in the
notification message the parameter value starts, and another regular expression that
determines from where in the notification message the parameter value ends. Define the
notification extraction rules when you create a server initiated starting point.

Editing Notification Extraction Rules
Edit notification extraction rules in the server-initiated starting point General properties.

1. On the Flow Design page, select the Server-initiated starting point.

2. In the General Properties view, select the notification extraction rule to edit and click
Edit.

3. In the Edit Notification Extraction Rule dialog:

Property Description

Field type Select the field in the notification from which
the parameter value is extracted, for example,
Subject, which indicates the parameter value is
extracted from the subject line of the notifica-
tion message.

Tag before parameter Enter the tag to indicate what to extract from the
beginning of the field's contents, for example,
"Approval Request\(".

Tag after parameter Enter the tag that indicates what to extract from
the end of the field's contents, for example,
"\)was sent".

Format Format uses the C# ParseExact syntax, and ap-
plies to DateTime only. It supports locale-spe-
cific parameter extraction. For example, you
can indicate that a given date parameter will be
in the form of yyyy-MM-dd in the e-mail, and
another date parameter will be in the form of
yyyy-dd-MM. This applies to the DateTime
type.

Key The key that the value from the notification is
extracted to.

Note: The supported syntax for the regular expression is that used by the C# Match()
methods(s) of the class System.Text.RegularExpressions.Regex.

4. Click OK.

The Mobile Workflow Forms Editor
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Editing the Server-initiated Starting Point
Edit the Server-initiated starting point.

1. In the Flow Design page, right-click the Server-initiated starting point to edit and select
Edit Server-initiated starting point.

2. Make your changes in the Notification Processing wizard and click Finish.

3. From the main menu, select File > Save.

Adding Matching Rules
Matching rules determine how notification messages are redirected at runtime.

To see the Matching Rules section of the Properties view, verify there are no objects selected
on the Flow Design page.

1. In the Properties view, click Matching Rules.

2. Click Add.

3. In the matching rules dialog, specify the type and regular expression for the matching rule,
and click OK.

Credentials
You can use either dynamic or static credentials in a mobile workflow form.

See the Developer Guide for Mobile Workflow Packages and System Administration for more
detailed information about implementing security and certificates.

The user name and password values are required when the mobile workflow application
invokes a mobile business object operation. These authentication values can be provided
statically (at design time), or dynamically (by the user at runtime).

Dynamic credentials mean that the user sets the user name and password on a screen that is
pointed to by the credential request starting point. The text fields must have the corresponding
Credential Cache User Name and Password checkbox checked to indicate the value is to be
used to provide the user name and password on the client. When the user logs in, the
credentials are authenticated using the stored credentials.

Note: If an e-mail triggered workflow form has dynamic cached credentials, the cached
credentials are not cached between invocations of the workflow form through an email trigger.

Static credentials mean that everyone who has access to the resource uses the same user name
and password. By default, static credentials are used. The static credential user name and
password for the mobile workflow application can be extracted from the selected Sybase
Unwired Platform profile user name and password when the mobile workflow application is
generated, or they can be hard-coded using the Properties view. After deployment, you can
change static credentials in the Sybase Control Center.

The Mobile Workflow Forms Editor
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The application can also have a credential screen (Credential Request) that appears if the
mobile workflow application detects that the cached credentials are empty or incorrect.

Setting Up Static Authentication
With static authentication, everyone who has access to the resource uses the same user name
and password.

Set up static credentials in the Authentication section of the Properties tab. To see the
Properties page, verify there are no objects selected on the Flow Design page.

1. In the Properties view, click Authentication.

2. Select Use static credentials.

3. Select from these options:

• Use SUP Server connection profile authentication – selected by default. When the code
is generated for the mobile workflow application, the user name and password
associated with the SUP connection profile are used.

• Use hard-coded credentials – sets the user name and password. When you select this
option, the User name and Password fields are activated.

• Use certificate-based credentials – when you select this option, you can use a
certificate to generate authentication credentials.

4. (Optional) If you selected the Use hard-coded credentials option in the previous step,
enter the User name and Password that are to be used for authentication.

5. Select File > Save.

Setting Up Static Authentication Using a Certificate
Set up static authentication credentials generated from a certificate.

1. In the Properties view, click Authentication.

2. Select Use static credentials and Use certificate-based credentials.

3. Click Generate from Certificate to select a certificate file from which to generate
authentication.

4. In the Certificate Picker, click Browse to locate the certificate to use.

5. Enter a password and select an alias, then click OK.

The information from the certificate is shown in the Properties view.
• Issuer – the issuer of the certificate
• Subject – the value of the subject field in the metadata of the certificate as defined in the

X.509 standard
• Valid from – the date the certificate is valid from
• Valid until – the date after which the certificate expires

6. Select File > Save.

The Mobile Workflow Forms Editor
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Setting Up Dynamic Authentication
Use dynamic authentication when you want the user to set the name and password on the
client.

You can create the Credential Request starting point with a Credential screen automatically
when you initially create a new mobile workflow, or you can create the Credential Request
starting point and associated screen manually. This procedure shows how to create the
Credential Request starting point automatically when you create a new mobile workflow.

1. In the Mobile Development perspective, select File > New > Mobile Workflow Forms
Editor.

2. Follow the instructions in the New Mobile Workflow Forms Editor wizard:

Field Description

Enter or select the parent folder Select the mobile application project in which
to create the mobile workflow form.

File name Enter a name for the mobile workflow form.
The extension for mobile workflow forms
is .xbw.

Advanced Link the mobile workflow form to an existing
file in the file system.

Link to file in the file system Click Browse to locate the file to which to link
the mobile workflow form. Linked resources
are files or folders that are stored in the file
system outside of the project's location. If you
link a resource to an editor, when you select the
editor, the resource is selected in the Work-
Space Navigator. Conversely, when you select
the resource in the WorkSpace Navigator, the
editor is selected.

Click Variables to define a new path variable.
Path variables specify locations on the file sys-
tem.

3. In the Starting Points page, select Credentials (authentication) may be requested
dynamically from the client application.

4. Continue with the New Mobile Workflow wizard as appropriate to create the type of
mobile workflow application you want to create. Click Finish.

5. When the Mobile Workflow Forms Editor opens, click Flow Design.

The Credential Request starting point and its associated Credential Request screen appear
on the Flow Design page.

The Mobile Workflow Forms Editor
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Select the Credential Request starting point. You see the two pre-defined keys
(cc_username and cc_password) in the Properties view.

6. Double-click the Credential Request screen to go to the Screen Design page.

Two editbox controls, which are bound to the pre-defined cc_username and cc_password
keys appear on the screen.

7. Select the Username editbox, then click Advanced on the left side of the Properties view.

The Username editbox has the Credential cache username checkbox selected. Select the
Password editbox and note that is has the Credential cache password checkbox checked.

If you create a Credential Request starting point and screen manually, you must add the
editbox controls, create the keys for the username and password, and check the
corresponding Credential cache username or password box.

8. (Optional) To use certificate-based authentication instead of the user name and password:

a) Add a MenuItem to the Menu box.
b) Select the MenuItem to see the Properties.
c) In the Properties view, from Type, choose Select Certificate.

When the user selects the menu item on the device, a dialog is opened that allows the
user to select a certificate to use for credentials.

9. Select File > Save.

The first time the mobile workflow is started following deployment, the credential screen
is shown. The username and password values are then cached in the credential cache.

Note: If an e-mail triggered workflow form has dynamic cached credentials, the cached
credentials are not cached between invocations of the workflow form through an email
trigger.

Creating Keys
Create new keys to bind to controls.

1. On the Screen Design page, select the control to which you want to bind the new key.

2. In General Properties, in the Input Data Binding section, click New key.

3. In the Key dialog, enter:

Property Description

Name Enter a name for the key.

Type Select the key type.

Sent by server Select this checkbox to input data binding for
the key.

Input Data Binding

The Mobile Workflow Forms Editor
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Property Description

MBO attribute Select to bind the key to a mobile business ob-
ject (MBO) attribute:
• Name
• Convert to UTC

MBO relationship Bind the key to an MBO relationship.

MBO object query results Bind the key to MBO object query results.

Hard coded value When the message is sent by the server to the
client, rather than getting the value of the key
from a source like an MBO attribute, it uses the
fixed value you input.

User defined Bind the key to user-defined data.

Extraction rule This is determined by the extraction rules you
set up.

4. Click OK.

Keys
Keys are unique identifiers within the scope of a workflow application, used when setting or
retrieving a value.

Keys can be bound to the mobile business object (MBO), whether it is to an MBO attribute, an
MBO parameter, an MBO operation parameter, a subscription parameter, an object query, or
an MBO relationship (list type keys only).

Keys can be of the following types:

• string
• int
• double
• decimal
• bool
• DateTime
• list – can be bound to relationships, or nothing. Keys of other types cannot be bound to

relationships. List type keys can also be bound to MBO object query results, which returns
multiple objects. List type keys have one or more child keys to which they are bound.

Binding Controls to Keys
Use the Properties view to bind keys to controls.

1. On the Screen Design page, select the control to which you want to bind the key.

The Mobile Workflow Forms Editor
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2. In General Properties, in the Input Data Binding section, select the key with which to bind
the control from the drop-down list.

3. (Optional) In Default Value, enter a default value for the key.

4. Select File > Save.

Flow Design Page Properties
These are the Flow Design page properties shown in the Properties view when no objects in the
Flow Design page are selected.

General

Property Description

Module name The name of the module.

Module version The version of the module.

Module description Enter a description for the module.

Module display name Enter the name that appears on the workflow ap-
plication when it is viewed on the client.

Delete message after processing If this option is selected, server-initiated work-
flow messages are removed from the device In-
box after they have been processed. A message is
considered to have been processed if the corre-
sponding workflow application is closed as a re-
sult of an asynchronous submit menu item being
activated.

Mark message as processed after processing If this option is selected, server-initiated work-
flow messages are marked as processed in the
device Inbox (indicated by a green check mark
over the original icon) after they have been pro-
cessed. A message is considered to have been
processed if the corresponding workflow appli-
cation is closed as a result of an asynchronous
submit menu item being activated.

Client icon Select the icon that appears on the client.

The Mobile Workflow Forms Editor
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Property Description

Credentials cache key Specify a key to use for the credential starting
point. If you do not enter anything, each work-
flow will have a different credentials key. If there
is more than one workflow with the same cre-
dentials key, then all of those workflows can share
the same credentials so that authentication for
each workflow does not have to be separately
defined.

Requires activation key Specify a key to use for activation. If you do not
enter anything, each workflow will have a differ-
ent activation key, which means that each work-
flow will have to be activated separately. If you
specify an activation key, then when you activate
one workflow, all the other workflows sharing the
specified activation key are automatically activa-
ted.

Rulers and grid

Property Description

Display • Show ruler

• Show grid

• Grid in front

Measurement • Ruler units

• Grid spacing

Grid line • Color

• Style

Snap to grid Automatically align objects to the grid lines on
the canvas.

Snap to shapes Position objects to grid lines that go through the
vertical and horizontal edges of other objects.

The Mobile Workflow Forms Editor
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Localization

Property Description

New Launch the New Locale wizard and create a new
locale file for the mobile workflow application.

Update Update the currently loaded locale file.

Load Load a locale properties file to the Mobile Work-
flow Designer.

Validate Select a locale properties file and click to validate.

Edit Select the locale properties file, then click to edit
the locale properties file.

Remove Select the locale properties file to remove, then
click to remove.

Matching rules
Any existing matching rules appear in the matching rules Properties view. Matching rules
determine how notifications are redirected at runtime.

Property Description

New Create a new matching rule.

Delete Select a matching rule and click to delete.

Edit Select a matching rule and click to edit.

Authentication

Property Description

Use static credentials Select when the authentication field is the same
for all users accessing the resource.

Use SUP server connection profile authentication Use properties from the connection profile to
supply credential data for authentication. This is
similar to hard-coded credentials but the creden-
tials are taken from the specified server connec-
tion profile instead of being specified in the Mo-
bile Workflow Forms Editor.

Use hard-coded credentials Specify a user name/password combination for
authentication.

The Mobile Workflow Forms Editor
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Property Description

User name This field is editable only if you selected the hard-
coded credentials option. Enter the user name to
use for authentication.

Password This field is editable only if you selected the hard-
coded credentials option. Enter the password to
use for authentication.

Use certificate-based credentials Click Generate from Certificate to select a cer-
tificate file from which to generate authentica-
tion. Once you choose the certificate to use, these
fields are filled in automatically.

• Issuer – the issuer of the certificate

• Subject – the value of the subject field in the
metadata of the certificate as defined in the
X.509 standard

• Valid from – the date the certificate is valid
from

• Valid to – the date the certificate is valid to

Unwired Server domain Optionally specify the Sybase Unwired Platform
domain to use. If specified, a context variable is
created in the application for which the initial
value is set to this domain. At runtime, when de-
termining authentication, @<domain> is added
to the user name, thus allowing the user access to
that domain.

See also
• Setting Mobile Workflow Forms Editor Preferences on page 3

• Creating a New Mobile Workflow Form on page 5

• Starting Points on page 8

• Flow Design Palette Options on page 24

• Screen Design Page Properties on page 28

• Screen Design Palette Options on page 30

• Mobile Workflow Forms Editor Context Menus on page 34

The Mobile Workflow Forms Editor
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Flow Design Palette Options
Use the items in the Mobile Workflow Forms Editor Flow Design palette to configure the
screens and connections for the mobile workflow application.

Connections

Connection Description

Go to Specifies which screen the user goes to upon
completing an action on the current screen, such
as clicking OK or Next.

Operation success Specifies which screen the user automatically
goes to upon successful completion of an opera-
tion.

Operation error Specifies the screen that the user goes to auto-
matically when an error occurs while attempting
to complete an operation.

Listview details Specifies which screen to open when a row in a
listview is clicked. Once on the details screen,
you can add, update, or delete rows from the list-
view.

Listview add Specifies a screen that can be directly navigated
to in order to add a new row to the listview.

Screen

Select the screen  and click the Flow Design page to create a new empty screen.

Starting points

Starting point Description

Activate The Activate starting point indicates a screen that
is displayed to the user the only the first time they
open the application. It is not displayed the sec-
ond and subsequent times the application is
opened. For example, you might want to use an
Activate starting pint to show usage instructions
for the application to the user the first time they
open the application.

The Mobile Workflow Forms Editor
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Starting point Description

Credential request Provide the credentials for authentication. During
execution, authentication credentials are evalu-
ated in this order:

1. User-defined user name and password keys

2. Credential cache

3. Specified generic credential pair

Server-initiated Use this starting point to define the matching
rules for the workflow form and to specify how to
extract values from notifications and map them to
mobile business object read and search parame-
ters.

Client-initiated The mobile business object referencing starting
point.

See also
• Setting Mobile Workflow Forms Editor Preferences on page 3

• Creating a New Mobile Workflow Form on page 5

• Starting Points on page 8

• Flow Design Page Properties on page 20

• Screen Design Page Properties on page 28

• Screen Design Palette Options on page 30

• Mobile Workflow Forms Editor Context Menus on page 34

Adding Connections to Screens

The Start icon  appears on the Flow Design page, and its connection is attached to the first
screen you add to the Flow Design. You can change the target to any screen in the Flow
Design.

1. From the Flow Design Palette, select the connection you want to use:

Note: Some connections cannot be explicitly created; they can only be implicitly created
when creating or editing menu item properties.

Connection Description

Go to Specifies which screen the user goes to upon
completing an action on the current screen,
such as clicking OK or Next.

The Mobile Workflow Forms Editor
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Connection Description

Operation success Specifies which screen the user goes to upon
successful completion of an operation.

Operation error Specifies the screen that the user goes to auto-
matically when an operation fails to execute.

Listview details Specifies which screen to open when a row in a
listview is clicked. Once on the details screen
you can add, update, or delete rows from the
listview.

Listview add Specifies a screen that can be directly navigated
to in order to add a new row to the listview.

2. In the Flow Design canvas, click the source screen and drag to connect it to the target
screen.
The connection line appears between the two screens.

Connections
Use connections to connect screens with actions in the Flow Design.

Connection actions describe the navigation direction the screen should go after the user
performs an action, cancels an action, or uses a control. Alert actions use actions defined in the
Flow Design.

Note: You can use only one connection of each type from a given source screen, except for the
GoTo and Operation Success connection types. You can have as many Operation Success
connections on a source screen as you have synchronous operations on the source screen. You
can have as many GoTo connection types as you want to on a source screen.

Connection Properties
Use the Properties view for connections to configure the connection properties.

Select the connection on the Flow Design page to view its properties.

The Mobile Workflow Forms Editor
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Property Description

Routing When a new connection is created, it uses the
default style defined in the preferences settings.
You can change the style of the connection line
individually in the Properties view.

• Styles:

• Oblique – connection lines are not
aligned with the horizontal or vertical
axis, and you can create breakpoints any-
where on the connection line. If you drag
the connection line, a new breakpoint is
created at the drag point and two lines are
created.

• Rectilinear – the connection line always
remains either horizontal or vertical.

• Tree – arranges the connection lines on
the Flow Design in a tree structure.

• Avoid obstructions – connection lines go
around objects.

• Closest distance – connection lines pass
through objects to shorten the distance of the
connection line.

Lines and arrows

Smoothness • None

• Less

• Normal

• More

Jump links • Status:

• None

• Below

• All

• Above

• Type:

• Semicircle

• Chamfered

• Square

• Reverse jump links

The Mobile Workflow Forms Editor
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Screen Design Page Properties
These are the Screen Design page properties shown in the Properties view when no objects in
the Screen Design page are selected.

General
These are the general properties for the screen.

Property Description

Name The name of the screen.

Key The key associated with the screen.

Background color Click Color picker to choose a background color
for the screen.

You can also enter the value manually. The pos-
sible values are black, blue, brown, gray, green,
orange, pink, purple, red, white, yellow, any
string with the format #rrggbb, where rr, gg

and bb are the hexadecimal values, in the range 0
to ff(255), for the red, green and blue.

OK action Select the action that will be performed when the
user clicks OK on the screen.

Rulers and grid
The ruler and grid properties are applied to the Screen Design page, or canvas.

Property Description

Display • Show ruler

• Show grid

• Grid in front

Measurement • Ruler units

• Grid spacing

Grid line • Color

• Style

Snap to grid Automatically align objects to the grid lines on
the canvas.
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Property Description

Snap to shapes Position objects to grid lines that go through the
vertical and horizontal edges of other objects.

Keys
Keys associated with the controls on the screen are shown.

Property Description

Key name The name of the associated key.

Type The type of the associated key, for example,
string.

Data binding Shows the data source to which the key is bound:

• Mobile business object attribute

• Mobile business object relationship

• MBO object query results

If you select an object query that returns mul-
tiple MBO instances, you can bind the result
set to a Listview control using a key that is of
the list type.

• User-defined

• Extraction rule

If you create a server-initiated starting point
that invokes an object query with a parameter,
this value is extracted from the email message
automatically.

Click New to create a new key.

Select any key and click Edit to edit the infor-
mation for an existing key.

Select a key and click Remove to remove an ex-
isting key.

See also
• Setting Mobile Workflow Forms Editor Preferences on page 3
• Creating a New Mobile Workflow Form on page 5
• Starting Points on page 8
• Flow Design Page Properties on page 20
• Flow Design Palette Options on page 24
• Screen Design Palette Options on page 30
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• Mobile Workflow Forms Editor Context Menus on page 34

Screen Design Palette Options
Use the items on the palette to design the screen for the mobile workflow application.

Option Description

Menu item Use to provide additional options for the top-level
menu on the screen.

Checkbox Displays a true/false (or yes/no) option on the
screen.

Editbox Select the logical type for the edit box, then enter
text and assign values to strings, dates, decimals,
integers, and so on.

Choice Display a collection of items on the screen as a
drop-down list from which the user can choose.

Slider Represent numeric values within a range.

Signature Add a signature box to the screen. The value is a
list of points that, combined, make up the signa-
ture that gets or is drawn to the control, for ex-
ample, -1x-1,5x7,5x8,-1x-1, where -1x-1 is in-
terpreted as an interruption of a line drawn to the
screen.
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Option Description

HtmlView Allows text with HTML markup to display on the
screen. For example, this code:

<H2>Travel Request App 1.0</H2> 
This application enables vaca-
tion requests to be 
sent for approval.<br>Contact 
Dan at extension 1234 
for technical support.

displays like this on the device:

Note: The HtmlView control fills the entire
screen of a workflow form, so no other controls
can be placed on a screen that hosts an HtmlView
control.

The Mobile Workflow Forms Editor
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Option Description

ListView Displays lines that can be clicked on to show fur-
ther details of the selected line. This facilitates the
navigation for a one-to-many mobile business
object relationship. For example, the listview
could contain the items of a sales order. When a
line in the sales order is clicked on, a details
screen for that sales order appears.

Note: The ListView control fills the entire screen
of a workflow form, so no other controls can be
placed on a screen that hosts a ListView control.

AttachmentViewer Allows the user to download and view attach-
ments on the device. A file viewer must be avail-
able on the device for the associated file type, for
example, .pdf, doc., xls, and so on.

See also
• Setting Mobile Workflow Forms Editor Preferences on page 3

• Creating a New Mobile Workflow Form on page 5

• Starting Points on page 8

• Flow Design Page Properties on page 20

• Flow Design Palette Options on page 24

• Screen Design Page Properties on page 28

• Mobile Workflow Forms Editor Context Menus on page 34

Adding Controls to the Screen
Use the Screen Design palette to add controls to the mobile workflow screen.

1. In the Mobile Workflow Forms Editor, select Screen Design > Palette > Controls, then
select the control you want to add to the screen and click on the screen.

2. Click the control to select it, then use the Properties page to configure it.

Mobile Workflow Controls
Controls are objects that users can interact with to view, enter, or manipulate data.

Supported controls are determined by the selected device. The set of supported controls
depends on the target device platform.

The Mobile Workflow Forms Editor
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Control Supported Platform

Checkbox • Apple iOS
• BlackBerry
• Android
• Windows Mobile Professional

Editbox • Apple iOS
• BlackBerry
• Android
• Windows Mobile Professional

Choice • Apple iOS
• BlackBerry
• Android
• Windows Mobile Professional

Slider • Apple iOS
• BlackBerry
• Android

Note: When the Optimize for performance op-
tion is set in preferences, the Slider control is
supported only on BlackBerry.

Signature • Apple iOS
• BlackBerry 6.0
• Android

Note: When the Optimize for Performance op-
tion is set in preferences, the Signature control is
not supported.

HtmlView • Apple iOS
• BlackBerry
• Android
• Windows Mobile Professional

Listview • Apple iOS
• BlackBerry
• Android
• Windows Mobile Professional

The Mobile Workflow Forms Editor
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Control Supported Platform

AttachmentViewer • Apple iOS
• BlackBerry
• Android
• Windows Mobile Professional

Mobile Business Object Relationships
When you are using two mobile business objects with a one to many or one to one composite
relationship defined, use the listview control on the mobile workflow application to show the
list of related objects.

The listview control allows you to navigate the one to many or one to one relationship between
the two mobile business objects. The one to one cascade relationships use regular controls or
keys that bind to the related mobile business object's attributes.

When you create the relationship between the two mobile business objects, you must select the
One to many or One to one and Composite options.

Note: Structured mobile business objects and complex parameters that have lists as child
elements are not supported in mobile workflow forms.

Mobile Workflow Forms Editor Context Menus
Right-click in any of the pages (except the Introduction page) of the Mobile Workflow Forms
Editor to display a context menu and perform these actions.

Option Description

Edit Edit the selected object.

Delete Delete the selected object.

Mobile Business Object References Shows current mobile business object references
and allows you to edit or delete existing mobile
business object references.

Note: This menu item appears only on the Flow
Design page.

Generate Mobile Workflow Package Generate the mobile workflow form code.
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Option Description

Send a notification Send an e-mail from the Mobile Workflow Forms
Editor to a device user. This can be used to quick-
ly test e-mail triggered applications. The test e-
mail bypasses the Notification Mailbox.

Note: The Cc and Bcc fields are used only for
matching rules. An e-mail is not sent to the users
entered in these fields.

Select Select:

• All – selects all objects on the page.

• All shapes – selects all shapes on the page.

• All connections – selects all connections on
the page.

Arrange all Arranges the shapes on the page.

View View:

• Grid

• Rulers

• Page breaks

• Recalculate page breaks

• Snap to grid

Zoom Select from the zoom options.

Show properties view Shows the Properties view for the selected object.

See also
• Setting Mobile Workflow Forms Editor Preferences on page 3

• Creating a New Mobile Workflow Form on page 5

• Starting Points on page 8

• Flow Design Page Properties on page 20

• Flow Design Palette Options on page 24

• Screen Design Page Properties on page 28

• Screen Design Palette Options on page 30
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Configuring Control Properties

Use the Properties page of any control to configure control properties.

1. On the Screen Design page, select the control for which to configure the properties.
The configurable properties for the selected control appear in the Properties view.

2. Configure the properties for the control and select File > Save.

Checkbox Properties
Select the checkbox on the Screen Design page to view and configure its properties.

General control properties
These are general properties for most controls.

Property Description

Label This property applies to all controls except
HtmlView and Listview.

• Label – enter the text that describes the con-
trol on the user interface.

• Label position – the position of the label in
relation to the control it describes.

Input data binding • Key – the unique identifier within the scope
of the widget, used when setting or retrieving
a value.

Click New key to create a new key for the
control.

• Default value – default value for the control.

Read only This property applies to all controls except
HtmlView and Listview. Select to make the con-
trol read-only.

Note: The read-only property is not supported on
the Windows Mobile platform for the Checkbox,
Slider, and Choice controls.

Advanced
These are the advanced validation properties for the checkbox control.

Configuring Control Properties
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Property Description

Required Specifies that submission is possible only when
the checkbox is selected. A submission must have
a value.

Validation message Specifies the error message that appears to the
user in case the input validation criteria do not
match.

Editbox Properties
Select Editbox on the Screen Design page to view and configure its properties.

General control properties
These are general properties for most controls.

Property Description

Label This property applies to all controls except
HtmlView and Listview.

• Label – enter the text that describes the con-
trol on the user interface.

• Label position – the position of the label in
relation to the control it describes.

Input data binding • Key – the unique identifier within the scope
of the widget, used when setting or retrieving
a value.

Click New key to create a new key for the
control.

• Default value – default value for the control.

Read only This property applies to all controls except
HtmlView and Listview. Select to make the con-
trol read-only.

Note: The read-only property is not supported on
the Windows Mobile platform for the Checkbox,
Slider, and Choice controls.

Editbox general properties
These are the general properties that apply to the editbox control.
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Property Description

Password If selected (set to true), text entered in the editbox
is replaced with asterisks. The default is false.

Logical type Select the logical type for the editbox:

• TEXT

• NUMERIC

• DATE – uses absolute values or values rela-
tive to the current day using simple calcula-
tions in days, for example,
“2008-05-24” "today" "today+1" "today-1."
All values are expected to be in UTC.

• DATETIME – uses absolute values or values
relative to the current time or day using sim-
ple calculations in seconds, for example,
"2008-05-24" or
"2008-05-24T14:30:15" "today" "today
+86400" or "today-86400." In "today+nnn,"
the nnn means seconds and "today" is inter-
preted as the current date time 12:00PM.

• TIME – uses only absolute values, for exam-
ple, "14:30" or "14:30:15." Valid values are
00:00:00 to 23.59:59.

Note: The properties that you can configure de-
pend on the logical type set for the editbox con-
trol. Some properties apply only to the numeric
type, some apply only to the text type, and so on.

Advanced
These are the advanced properties that apply to the editbox.
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Property Description

Content size • Maximum length – specify the maximum
number of characters allowed for the control.

• Number of lines – specify the number of lines
for the control.

• Number of decimals – specify the number of
decimals (the number of digits after the dec-
imal point—valid range is 0 – 28) for a num-
ber. Valid only in conjunction with numeric
attributes. The default is zero.

Validation • Minimum value – specify the minimal value
for numeric input. Valid only in conjunction
with numeric attributes.

• Maximum value – specify the maximum val-
ue for numeric input. Valid only in conjunc-
tion with numeric attributes.

• Required – specify if user input is required. A
value is required for submission.

• Validation regular expression – if the user
enters text in the control, the input has to
comply to the provided regular expression.

• Validation message – enter the error message
the user sees in case the input validation cri-
teria do not match.

Time precision Specifies the precision of the time portion dis-
played to the user and calculations.

Note: This property is used only if the editbox
logical type is datetime or time.

Credential cache username If the widget supports cached credentials, select
to specify that the editbox be treated as a user
name.

Credential cache password If the widget supports cached credentials, select
to specify that the editbox be treated as a pass-
word.
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Choice Properties
Select the choice control on the Screen Design page to view and configure its properties.

General control properties
These are general properties for most controls.

Property Description

Label This property applies to all controls except
HtmlView and Listview.

• Label – enter the text that describes the con-
trol on the user interface.

• Label position – the position of the label in
relation to the control it describes.

Input data binding • Key – the unique identifier within the scope
of the widget, used when setting or retrieving
a value.

Click New key to create a new key for the
control.

• Default value – default value for the control.

Read only This property applies to all controls except
HtmlView and Listview. Select to make the con-
trol read-only.

Note: The read-only property is not supported on
the Windows Mobile platform for the Checkbox,
Slider, and Choice controls.

Choice general properties
These are the general properties that apply to the choice control.
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Property Description

Logical type Select the logical type for the edit box from the
drop-down list. Logical types include:

• TEXT

• NUMERIC

Note: The properties that you can configure de-
pend on the logical type set for the control. Some
properties only apply to the numeric type and
some only apply to the text type.

Options • Static – the choice contents are static. Click
Add to assign a display name and value pair
to the choice item.

• Dynamic – the choice contents are dynamic.

Advanced
These are the advanced properties that apply to the choice control.

Property Description

Content size Number of decimals – specify the number of
decimals (the number of digits after the decimal
point—valid range is 0 to 28) for a number. Only
valid in conjunction with the numeric attributes.
The default is zero.

Note: This property is used only if the logical
type for the choice control is set to numeric.

Validation required • Required – specify if user input is required. A
submission without a value is not possible.

• Validation message – enter the error message
displayed to the user in case the input valida-
tion criteria do not match.

Adding Choice Items to the Choice Control
Add choice items to the choice control.

1. In the General Properties view for the choice control, click Add.

2. In the Choice Option Item dialog, enter the Display Name and Value for the choice item,
and click OK.
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Property Description

Display Name Enter the name for the choice item as it will
appear on the user interface.

Value Enter the value for the choice item.

Editing Choice Items
Edit choice items for the choice control.

1. In the General Properties view for the choice control, select the choice control item to edit
and click Edit.

2. In the Choice Option Item dialog, make the changes and click OK.

Property Description

Display Name Enter the name for the choice item as it will
appear on the user interface.

Value Enter the value for the choice item.

Deleting Choice Items
Delete choice items from the choice control.

1. In the General Properties view for the choice control, select the choice control item to
delete.

2. Click Delete.

Creating Dynamic Contents for the Choice Control
Specify contents of the choice control dynamically.

1. In the Screen Design page, select the Choice item from Palette > Controls and drag it onto
the screen.

2. In the General Properties view for the choice control, from the Options section, select
Dynamic.

3. In Value key, enter the value for the key.

4. In Display name key, enter the value that the user will see on the device interface.

Note: The display name key and the value name key can be different or the same. The two
keys must be children of a key that is a list type.
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Slider Properties
Select the slider control on the Screen Design page to view and configure its properties.

General control properties
These are general properties for most controls.

Property Description

Label This property applies to all controls except
HtmlView and Listview.

• Label – enter the text that describes the con-
trol on the user interface.

• Label position – the position of the label in
relation to the control it describes.

Input data binding • Key – the unique identifier within the scope
of the widget, used when setting or retrieving
a value.

Click New key to create a new key for the
control.

• Default value – default value for the control.

Read only This property applies to all controls except
HtmlView and Listview. Select to make the con-
trol read-only.

Note: The read-only property is not supported on
the Windows Mobile platform for the Checkbox,
Slider, and Choice controls.

Slider control general properties
These are the general properties that apply to the slider control.

Table 1. Value constraints

Property Description

Minimum value Specify the minimum value.

Maximum value Specify the maximum value.

Configuring Control Properties

44 Sybase Unwired Platform



Advanced
These are the advanced properties that apply to the slider control.

Property Description

Validation message Specifies the error message displayed to the user
in case the input validation criteria do not match.

Signature Properties
Select the signature control on the Screen Design page to view and configure its properties.

Note: The signature control is not supported on iOS devices, or when the Optimize for
Performance option is set in preferences.

General control properties
These are general properties for most controls.

Property Description

Label This property applies to all controls except
HtmlView and Listview.

• Label – enter the text that describes the con-
trol on the user interface.

• Label position – the position of the label in
relation to the control it describes.

Input data binding • Key – the unique identifier within the scope
of the widget, used when setting or retrieving
a value.

Click New key to create a new key for the
control.

• Default value – default value for the control.

Read only This property applies to all controls except
HtmlView and Listview. Select to make the con-
trol read-only.

Note: The read-only property is not supported on
the Windows Mobile platform for the Checkbox,
Slider, and Choice controls.
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Advanced
These are the advanced properties that apply to the signature control.

Property Description

Validation Required • Required – specify if user input is required. A
submission without a value is not possible.

• Validation message – enter the error message
displayed to the user in case the input valida-
tion criteria do not match.

HtmlView Properties
Select the HtmlView control on the Screen Design page to view and configure its properties.

The HtmlView control fills the entire screen of a workflow form, so no other controls can be
placed on a screen that hosts an HtmlView control.

Table 2. HtmlView control properties

Property Description

Input data binding • Key – the unique identifier within the scope
of the workflow form, used when setting or
retrieving a value.

Click New key to create a new key for the
control.

• Default value – default value for the control.

Listview Properties
Select Listview on the Screen Design page to view and configure its properties.

General Listview properties

Property Description

Input data binding Select the key with which to bind the Listview
control from the drop-down, or click New key to
create a new key.
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Property Description

Alternate row color Click Color Picker to select the color for the
alternate rows in the list.

You can also manually enter the value. The pos-
sible values are black, blue, brown, gray, green,
orange, pink, purple, red, white, yellow, any
string with the format #rrggbb, where rr, gg

and bb are the hexadecimal values, in the range 0
to ff(255), for the red, green and blue.

Note: The alternate row color attribute is suppor-
ted on Windows Mobile devices only.

On empty list The text that appears on the screen when the List-
view is empty.

Show header When selected, column titles appear in the List-
View control.

Wrap data in PRE and CODE tags If the text to be displayed is HTML, select if you
do not want the HTML rendered. If selected,
HTML markup is filtered out and the data is dis-
played on the device as text.

Listview details screen Select the screen that will be opened when the
user clicks a row.

Cells

Property Description

Cell lines The lines that appear in each row of the control.
Click Add to add a new line. Select an existing
line and click Delete to remove a line from the
row. Use the Up and Down buttons to move the
cell lines up or down.

Fields for cell line Click Add to create a new field.

Click Edit to edit an existing field.

Click Delete to delete an existing field.

Use the Up and Down buttons to move the cell
line fields up or down.

Configuring Control Properties

Sybase Unwired WorkSpace - Mobile Workflow Package Development 47



Adding a Listview Field to a Line
Use the Properties view to add fields to Listview lines.

1. Select the Listview control to see the Properties view.

2. In Properties, in the left pane, click Cell.

3. In Cell lines, select the line for which to add the field.

4. In Fields for click Add.

5. In the Listview Field dialog:

Option Description

Key Select the key with which to associate the field.

Field width Enter the field width. This value is a percentage,
so the values entered should be between 1 – 100
and add up to 100.

Font options Select the appearance of the font:
• Plain
• Bold
• Italic

Field header title Enter a field header title for the cell line.

6. Click OK.

Editing a ListView Field
Edit ListView control fields in the Properties view.

1. Select the ListView control to see the Properties view.

2. In Properties, in the left pane, click Lines.

3. In Fields for ListView Line, select the line for which to edit the field and click Edit.

4. In the ListView Field dialog, make your changes and click OK.
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AttachmentViewer Properties
Select AttachmentViewer on the Screen Design page to view and configure its properties

General

Property Description

Label • Label – enter the text that describes the con-
trol on the user interface.

• Label position – the position of the label in
relation to the control it describes.

Input data binding Select the key with which to bind the Attach-
mentViewer control, or click New key to create a
new key.

• Key – the unique identifier within the scope
of the workflow form, used when setting or
retrieving a value.

Click New key to create a new key for the
control.

• Default value – default value for the control.

Read-only Select to make the control read-only.
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Property Description

Content • Use object query –select to invoke a specified
object query.

• Mobile business object – select the mo-
bile business object that contains the ob-
ject query to invoke

• Object query – specify the object query to
invoke

• Attribute –specify the binary attribute
value that corresponds to the attachment
contents

• MIME type key – mime type for attachments
that are supported, for example, *.doc, *.xls
and so on

• File name – name of the file

• File size – size of the file

Note: Attachments requested on demand are
limited to 5MB after Base64 encoding.

Parameter Mapping
Use the Parameter Mapping section to bind the parameters (if any) of an operation or object
query to keys or, context data, such as DeviceName, BackEndPassword, BackEndUser, and so
on.

Personalization Key Mappings
If you have a mobile business object with load parameters mapped to transient personalization
keys, you can specify values for those personalization keys when you invoke an operation or
object query from the Mobile Workflow package. This can, for example, be useful for loading
only specific data into the consolidated database from large data sources.

Supported Attachment Types
This shows which device platforms support which attachment file type.

Device platform File types

iPhone *.jpg, *.jpeg, *.png, *.tif, *.tiff, *.gif, *.doc,
*.docx, *.xls, *.xlsx, *.ppt, *.pptx, *.pdf, *.htm,
*.html, *.txt
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Device platform File types

BlackBerry *.gif, *.jpg, *.png, *.bmp, *.txt, *.html

Installing an attachment viewer like Documents
To Go Premium Edition allows you to view add-
tional file types, such as *.pdf, *.doc, *.xls,
*.xlsx, *.ppt, and *.pptx.

Windows Mobile *.doc, *.xls, *.xlsx, *.ppt, *.pptx, *.gif, *.jpg,
*.png, *.bmp, *.txt, *.html. *.mp3

PDF support requires the user to install a PDF
viewer on the device.

Android *.gif, *.jpg, *.png, *.bmp, *.txt, *.html

Other file types, like Microsoft and Adobe, can be
supported by installing additional applications on
the device.
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Sybase Unwired WorkSpace - Mobile Workflow Package Development 51



Configuring Control Properties

52 Sybase Unwired Platform



Adding a Menu Item

Add a menu item to the menu.

If you manually create a menu item that invokes an object query, it will automatically create an
output key, which is a list and which has keys that are bound to the attributes of that mobile
business object.

1. On the Screen Design page, from Palette, select Menuitem, then click the Menu box.

2. Select the menu item to configure the properties in the Properties view.

Menu Items
Menu items function as actions and are associated with mobile business object operations.

Each action in the Mobile Workflow application results in a native menu item being generated
when you generate the files for the Mobile Workflow package. Native menu support is
provided on BlackBerry, Android, and Windows Mobile platforms. On the iOS platform,
menus are provided from HTML controls designed to emulate the iPhone navigation bar and
toolbar.

• Save screen – closes the current screen, validates the current input and, if validation
succeeds, saves it.

• Cancel screen – discards any changes on the current screen and closes it. No validation
occurs.

• Close workflow – discards any changes on any open screens and closes all open screens.
No validation occurs.

• Open screen – opens a different screen.
• Online request – creates a synchronous call to the server, validates the data input on all

open screens, saves it, sends it to the server and waits for a response from the server before
continuing.

• Submit workflow – creates an asynchronous call to the server, validates the data input on
all open screens, closes the application, and sends the data to the server. You cannot use a
Submit Workflow action to invoke an operation on a nested, or child, element.

• Select certificate – opens a dialog where the user can choose a certificate to use for the
credentials.

• Create/Update/Delete Key Collection – adds, updates, or deletes a key from a key
collection from a list key bound to a Listview control. These operations are not invoked
immediately, but are instead invoked when a Submit operation is made on the parent MBO
to which this MBO is related. It can be added only to screens that are navigated to as the
result of a Listview details navigation, for example, by clicking a row in a Listview.
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Menu Item Properties
Select the menu item on the Screen Design page to view and configure its properties using the
Properties page.

General

Property Description

Name Enter a valid name for the menu item.

Note: To avoid wrapping of menu item names on
Apple iOS devices, keep the name length to 10 or
fewer characters.

Key Select the key with which to bind the menu item.

Default Select to display the menu item prominently on
the screen.
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Property Description

Type • Save screen – closes the current screen, vali-
dates the current input and, if validation suc-
ceeds, saves it.

• Cancel screen – discards any changes on the
current screen and closes it. No validation
occurs.

• Close workflow – discards any changes on
any open screens and closes all open screens.
No validation occurs.

• Open screen – opens a different screen.

• Online request – creates a synchronous call to
the server, validates the data input on all open
screens, saves it, sends it to the server and
waits for a response from the server before
continuing.

• Submit workflow – creates an asynchronous
call to the server, validates the data input on
all open screens, closes the application, and
sends the data to the server. You cannot use a
Submit Workflow action to invoke an opera-
tion on a nested, or child, element.

• Select certificate – opens a dialog where the
user can choose a certificate to use for the
credentials.

• Create/Update/Delete Key Collection – adds,
updates, or deletes a key from a key collection
from a list key bound to a Listview control.
These operations are not invoked immediate-
ly, but are instead invoked when a Submit
operation is made on the parent MBO to
which this MBO is related. It can be added
only to screens that are navigated to as the
result of a Listview details navigation, for
example, by clicking a row in a Listview.

Details You can configure menu item actions in the De-
tails section. The properties available depend on
the action type. See the topics for configuring the
different menu item types for information about
configuring these properties.
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Parameter Mapping
Use the Parameter Mapping section to bind the parameters (if any) of an operation or object
query to keys or, context data, such as DeviceName, BackEndPassword, BackEndUser, and so
on.

Personalization Key Mappings
If you have a mobile business object with load parameters mapped to transient personalization
keys, you can specify values for those personalization keys when you invoke an operation or
object query from the Mobile Workflow package. This can, for example, be useful for loading
only specific data into the consolidated database from large data sources.

Output Keys
Lists the keys of which values will be filled by the server and returned to the client. Output keys
are used only with an Online Request menu item type.

Creating a Save, Open, Close, or Cancel Menu Item
Create a menu item that performs a save, open, close, or cancel action on the device
application screens.

Note: The first screen in each mobile workflow form should have a Close or Cancel menu
action assigned to it so that the user can exit from the mobile workflow form on the device. On
a Windows Mobile device, the user can exit by clicking the OK button, but not all devices have
that function.

1. On the Screen Design page, from Palette, click Menuitem, then click the Menu box.

2. Select the menu item to configure the properties in the Properties view.

3. In the Properties view:

Property Description

Name Enter a valid name for the menu item.

Note: To avoid wrapping of menu item names
on Apple iOS devices, keep the name length to
10 or fewer characters.

Key Select the key with which to bind the menu
item.

Default Select to display the menu item prominently on
the screen.
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Property Description

Type Select the type of action the menu item will
perform when selected:
• Save – allows the user to close the current

open screen and save the input made to the
collection of response values to be sent to
the server.

• Close – allows the user to leave the client-
side component no matter which screen the
client-side component currently shows.

• Cancel – allows the user to close the current
open screen without performing any data
validation. The cancel action type immedi-
ately navigates the user back to the under-
lying screen.

• Open – indicates the screen to be opened
with a GoTo connection. The Open type
menu item must be associated with a screen
on the Flow Design.

Screen This field appears in the Details section only if
the menu item type is Open. Select the screen
that will open from the GoTo connection.

4. Select File > Save.

Creating a Submit Workflow Menu Item
A Submit Workflow menu item, allows the user to update, delete, or create data even when not
connected to the network. When the user connects, data is automatically sent and received.

The submit menu item of the first screen in a mobile workflow form must be associated with a
mobile business object (MBO) operation or an object query.

If the user has multiple screens open at the time of the submit execution, and one of the
underlying screens fails validation, the user is prompted with the configured warning message
and the submit process stops.

1. From the palette on the Screen Design page, click Menuitem, then click the Menu box.

2. From the Properties view, select the menu item for which to configure the properties.

3. In the Properties view, configure the properties for the submit menu item:
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Property Description

Name Enter a valid name for the menu item.

Note: To avoid wrapping of menu item names
on Apple iOS devices, keep the name length to
10 or fewer characters.

Key Select the key with which to bind the submit
menu item.

Default Select to display the menu item prominently on
the screen.

Type Select Submit Workflow.

4. If the menu item is an operation associated with a mobile business object, you can
configure these properties in Details:

Property Description

Mobile business object The MBO with which the menu item is associ-
ated. Click Search to locate the MBO.

Invoke parent update No changes are made to the parent MBO, but
the appropriate operations (create, update, de-
lete) are performed on its descendants.

Invoke operation Invoke the selected MBO operation with which
the menu item is associated.

Select the operation from the list, which is
populated when you select the MBO.

Invoke object query Invoke the object query from the menu item.

Generate old value keys By default, this is selected, which means when
data is sent, there are two copies sent—one with
the key names you select at design time, and one
with the same names prefixed with "_old." The
keys you selected at design time may get up-
dated by the application, but the old values will
not unless this option is selected. Those "_old"
value keys may be critical when executing an
update or parent update operation at a later
time. If you unselect this option, old value keys
are not generated.

Submit confirmation message (Optional) Enter text to show in a message box
on the screen when the submit operation fin-
ishes successfully.
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Property Description

Resubmit confirmation message (Optional) Enter text to show in a message box
on the screen when the submit was not success-
ful and thus must be resubmitted.

5. Select File > Save.

Creating an Online Request Menu Item
Create an online request menu item for synchronous calls to Unwired Server, which means the
device client waits for a response from the server.

1. From the palette on the Screen Design page, click Menuitem, then click the Menu box.

2. In the Properties view, select the menu item for which to configure the properties.

3. In the Properties view, configure the properties for the online request menu item:

Property Description

Name Enter a valid name for the menu item.

Note: To avoid wrapping of menu item names
on Apple iOS devices, keep the name length to
10 or fewer characters.

Key Select the key with which to bind the online
request menu item.

Default Select to display the menu item prominently on
the screen.

Type Select Online Request.

4. If the menu item is an operation associated with a mobile business object (MBO), you can
configure these properties in the Details section:

Property Description

Mobile business object The MBO with which the menu item is associ-
ated. Click Search to locate the MBO.
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Property Description

Invoke parent update No changes are made to the parent MBO, but
the appropriate operations (create, update, de-
lete) are performed on its descendants.

Invoke operation Invoke the selected MBO operation with which
the menu item is associated.

Select the operation from the list, which is
populated when you select the MBO.

Invoke object query Invoke the object query from the menu item.

Generate old value keys By default, this is selected, which means old
value keys are generated. If you need the old
value keys for update or parent update opera-
tions, you should leave this selected. If you un-
select it, old value keys will not be generated.

Submit error message Enter the message the user sees if there is an
error during the submit operation.

When an operation is invoked, the user can re-
ceive any error messages that may occur on the
client application. The error messages are a
single key of the List type, with a single key of
the String type as its child. Each child instance
corresponds to an error message.

Timeout Enter the allowed amount of time, in seconds, to
wait for the server to respond before timing out
and giving an error message.

On device cache timeout Represents the time, in seconds, that query re-
sults are cached on the device. If the same query
is made with the same parameter values within
the specified timeout, the results are pulled
from the device cache and no call to the server is
made.

Success screen The screen to go to upon successful communi-
cation with the server.

Error screen The screen to go to if there is an error when
submitting the data to the server.

Click Generate Error Screen to automatically
generate error screens.

5. (Optional) Click Parameter Mappings to define the keys to map to parameters.

You see the parameters defined for the MBO and used to generate the object query. In
addition to Key, you can map parameters to BackEndPassword, BackEndUser, DeviceId,
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DeviceName, DeviceType, UserName, MessageId, ModuleName, ModuleVersion, and
QueueId.

6. (Optional) Click Personalization Key Mappings to select a personalization key and the
key to which it maps.

You can also fill the personalization key values from values extracted from the notification,
depending on from where you are invoking the object query.

7. (Optional) Click Output Keys to view the keys that will be created and populated based on
the selected action.

8. Select File > Save.

Creating a Key Collection Menu Item
Create and configure a Key Collection menu item.

1. In the Screen Design page, from the palette, click Menuitem, then click the Menu box.

2. Click the menu item to select it and configure the properties in the Properties view.

3. In the Properties view:

Property Description

Name Enter a valid name for the menu item.

Note: To avoid wrapping of menu item names
on Apple iOS devices, keep the name length to
10 or fewer characters.

Key Select the key with which to bind the key col-
lection menu item.

Default Select to display the menu item prominently on
the screen.

Type Select one of these types:
• Add Key Collection
• Update Key Collection
• Delete Key Collection

4. If the menu item is an operation associated with a mobile business object, configure these
properties in Details.

Property Description

Mobile business object The mobile business object with which the
menu item is associated. Click Search to locate
the mobile business object with which to asso-
ciate the menu item.
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Property Description

Invoke parent update No changes are made to the parent MBO, but
the appropriate operations (create, update, de-
lete) are performed on its descendants.

Invoke operation The mobile business object operation with
which the menu item is associated. Select the
operation from the list, which is populated
when you select the mobile business object.

Invoke object query Invoke the object query from the menu item.

Generate old value keys By default, this is selected, so that old value
keys are generated. If you need the old value
keys for update or parent update operations,
leave this selected. If you unselect it, old value
keys are not generated, which results in a much
smaller message, which improves perform-
ance.

ListView Select the Listview from the drop-down list.

5. Select File > Save.

Configuring Parameter Mappings
Configure mapping between parameters and keys or context data.

Parameter mappings for the selected operation or object query are shown in the Properties
view.

1. In the Properties view for the menu item, select the Parameters Mapping tab.

2. Click Add to map a key or context data, such as BackEndUser, BackEndPassword,
DeviceName, UserName, MessageID, and so on to a parameter.

3. Select a key, and click Edit to edit mapping between a parameter and a key or context
data.

4. Select a key and click Delete to delete existing mapping between a key or context data and
a parameter.
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Localization and Internationalization

You can localize different objects in the Mobile Workflow Forms Editor, such as the names of
screen controls, screens, and mobile business objects.

You can localize the mobile workflow by creating locale properties files. You can then load,
update, and generate localized mobile workflow applications.

All the localizable strings in the Mobile Workflow Forms Editor XML model work as resource
keys in the localization properties file. All the localization properties files are in the same
directory as the Mobile Workflow packages (.xbw files).

Resource keys are divided into these categories, which include all the elements of the Mobile
Workflow Forms Editor XML model:

• Menus
• Controls
• Screens

Localization consists of two levels of localization—the Mobile Workflow Forms Editor XML
model localization and the Mobile Workflow client localization.

All locale properties files are saved in the same directory as the Mobile Workflow package.

Localization Limitations
Some restrictions for the locale properties files apply:

• Mobile workflow applications that have names that begin with numbers or special
characters cannot be localized; you will receive an error when you generate the code. Make
sure that any mobile workflow you want to localize does not have a file name that begins
with a number or special character.

• When you specify a country for the language, the basic language locale must also be
available. For example, if you create a locale and specify English as the language and the
United States as the country, then a locale for English (the basic language) must also be
available.

• If you create a locale that specifies language, country, and variant, the locale for the basic
language and the locale for the basic language and the country must be available. For
example, if you create a locale and specify English as the language, United States as the
country, and WIN as the variant, then English (United States) and English locales must
also be available.

• The language code must be a 2-letter code, and the country code can be either a 2-letter or
3-letter code.
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• If you specify a variant, the country code must be a 2-letter code.

See also
• Localizing a Mobile Workflow Package on page 64

• Mobile Workflow Package Internationalization on page 72

• Internationalization on the Device on page 74

Localizing a Mobile Workflow Package
Use the Mobile Workflow Forms Editor to complete these tasks to localize Mobile Workflow
packages (.xbw files).

1. Creating and Validating a New Locale Properties File

Goal: Create a locale properties file as the default locale.

2. Editing the Locale Properties File

Goal: Edit the locale properties file.

3. Deploying the Mobile Application Project

Goal: Deploy the mobile business objects to Unwired Server.

4. Configuring the Device for Localization

Goal: Configure the device.

5. Removing a Locale

Remove locale properties files.

6. Updating the Current Locale

Update the currently loaded locale properties file with the resource keys from the current
Mobile Workflow Designer.

See also
• Localization Limitations on page 63

• Mobile Workflow Package Internationalization on page 72

• Internationalization on the Device on page 74

Creating and Validating a New Locale Properties File
Goal: Create a locale properties file as the default locale.

Prerequisites
You must have an existing Mobile Workflow package before you create the locale properties
file.

Localization and Internationalization
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Task
When you create a new locale, keep in mind:

• When you specify a country for the language, the basic language locale must also be
available. For example, if you create a locale and specify English as the language, then
there must also be a locale for English (the basic language).

• If you create a locale that specifies language, country, and variant, the locale for the basic
language and the locale for the basic language and the country must be available. For
example, if you create a locale and specify English as the language, United States as the
country, and WIN as the variant, then English (United States) and English locales must
also be available.

1. In WorkSpace Navigator, double-click the <mobile_workflow>.xbw file to open the
Mobile Workflow Forms Editor.

2. Click the Flow Design tab.

3. Right-click in a blank area on the Flow Design page, and select Show Properties View.

4. In the Properties view, on the left, click the Localization tab.

5. In the right pane, click New.

6. Select or enter the information for the new locale, select Automatically create default
locale, and click Finish.

Option Description

Language Select the language.

Country Select the country.
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Option Description

Variant Enter the variant, which is the vendor or brows-
er-specific code. For example, enter "WIN" for
Windows, "MAC" for Macintosh and "POSIX"
for POSIX. If there are two variants, separate
them with an underscore, and put the most im-
portant one first. For example, a Traditional
Spanish collation might construct a locale with
parameters for language, country, and variant
as: "es", "ES", "Traditional_WIN".

Overwrite existing file Overwrite an existing localization file.

Automatically create default locale Automatically create the default locale proper-
ties file. For example, if you specify the lan-
guage as "English" and the country as the
"United States" for a device application called
test, then both test_en_uS.prop-
erties and test.properties files
are created.

For example:
• Language – select French.
• Country – select France.
• Variant – enter a value to make this locale file unique from others, for example, WM for

Windows Mobile.
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This locale file is now the default locale file, and will be used when the regional setting of
the device does not match that of any supplied locale file.

7. In the Properties view, in the Localization page, select the file to validate and click
Validate.

The properties file is scanned and if there are any errors, a dialog appears. Click Yes to
correct the errors automatically; click No to see the errors in the Problems view.

See also
• Editing the Locale Properties File on page 68
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Editing the Locale Properties File
Goal: Edit the locale properties file.

1. In WorkSpace Navigator, under the Generated Code folder, right-click the locale
properties file you created, and select Open With > Properties File Editor.

2. You can make and save changes to the file in the Properties File editor, for example, you
can replace all the values of the resource keys with Chinese characters.

3. Select File > Save.

The next time you open the locale properties file, notice that all of the ASCII characters
have been changed.

4. In the Localization pane, select the localization file you edited, and click Load.

The elements of the application in the editor are translated into the language you specified
if the localization file passes the loading validation.

See also
• Creating and Validating a New Locale Properties File on page 64

• Deploying the Mobile Application Project on page 68

Deploying the Mobile Application Project
Goal: Deploy the mobile business objects to Unwired Server.

Prerequisites
Unwired Server must be running.

Task

Use this procedure to deploy any mobile application project you are using.

1. In WorkSpace Navigator, right-click the <mobile_application_project> folder, and
select Deploy Project.
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2. In the Deploy Mobile Application Project wizard, make your selections and click Next.

3. In the Contents page, select all the mobile business objects (MBOs) and click Finish.

4. In the Deployment status window, click OK.

5. When the deployment completes, click File > Close.

6. Generate the files for the Mobile Workflow package.

See also
• Editing the Locale Properties File on page 68

• Configuring the Device for Localization on page 69

Configuring the Device for Localization
Goal: Configure the device.

Keep in mind that the device you are testing may be different from the devices available to
consumers in other geographies, and the locales available on your device may be different
from those available on other devices.

1. For Windows Mobile:

a) Go to Settings > System > Regional Settings.
b) Click Region.
c) Change the region to the desired locale, for example, French (France) or Chinese

(China).
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Note: The locales that appear in the Regional Settings depend on what you have
installed on your device.

2. For iPhone devices:

a) Go to Settings > General > International > Language.
b) Change the Language setting to the desired language, for example, Francais, and click

OK.
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c) From Settings > General > International > Language > Region Format, select the
corresponding Region Format and click OK.

3. For Android devices:

a) Go to Settings > Locale and text > Select locale.
b) Change the region to the desired locale, for example, English (Australia).

See also
• Deploying the Mobile Application Project on page 68

• Removing a Locale on page 71

Removing a Locale
Remove locale properties files.

1. In the Screen Design page Properties view, click Localization.

2. Select the locale to remove and click Remove.
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3. Click Yes to confirm the deletion.

See also
• Configuring the Device for Localization on page 69

• Updating the Current Locale on page 72

Updating the Current Locale
Update the currently loaded locale properties file with the resource keys from the current
Mobile Workflow Designer.

If the locale properties file does not already exist, it is created. If the current locale is not
defined in the mobile workflow application file, the updated locale is used as the default, and
the file name is {device_application}.properties. Otherwise, the locale defined in the mobile
workflow application file is updated.

1. In the Screen Design page Properties view, click Localization.

2. Click Update.

See also
• Removing a Locale on page 71

Mobile Workflow Package Internationalization
The internationalization feature depends on the internationalization setting on the operating
system where Sybase Unwired Platform Mobile Workflow is running.

In the Mobile Workflow Forms Editor, you can use international data in:

• Matching rules for notifications.
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• Key names – you can create keys with names in other languages and map them to mobile
business object parameters.
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• Generated Code folder – you can include languages other than English in the code
generation path based on the name of the selected language.

See also
• Localization Limitations on page 63

• Localizing a Mobile Workflow Package on page 64

• Internationalization on the Device on page 74

Internationalization on the Device
On the device, e-mail messages and data can include languages other than English.

The internationalization feature depends on the internationalization setting on the device
where the Mobile Workflow client running.

E-mail messages can be sent and received using Chinese, for example, which can then be used
to extract the parameter. You can also create and update records in using international data,
such as Chinese. For example:
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See also
• Localization Limitations on page 63

• Localizing a Mobile Workflow Package on page 64

• Mobile Workflow Package Internationalization on page 72
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Sending a Test Notification

Send a test notification from the Mobile Workflow Forms Editor to a device user to test server-
initiated Mobile Workflow forms.

1. Right-click in the Flow Design or Screen Design page of the Mobile Workflow Forms
Editor and select Send a notification.

2. Fill out the notification form and click Send.

Note: The Cc and Bcc fields are used only for matching rules. A notification is not sent to
the users entered in these fields.

The notification bypasses the Notification Mailbox.

3. (Optional) Click Get Device Users to bring up a list of registered device users to whom
you can send the notification.

Sending a Test Notification
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Generating the Files For a Mobile Workflow
Package

Use the Mobile Workflow Package Generation wizard to generate the files for the mobile
workflow form, optionally deploy the generated workflow package files to the server, and
assign it to one or more users' devices.

1. Right-click in either the Flow Design or Screen Design page of the Mobile Workflow
Forms Editor and select Generate Mobile Workflow Package, or click the code
generation icon  on the toolbar.

2. In the Mobile Workflow Package Generation wizard, enter or select:

Option Description

Favorite configurations (Optional) Select a configuration.

Package Generation and Deployment

Generate Select to generate the mobile workflow pack-
age and its files. When this option is unchecked,
the Mobile Workflow package files are not re-
generated, so that modifications made to files
that are normally regenerated will not be over-
written. This also means, however, that changes
made in the Mobile Workflow editor will not be
reflected in the generated files..

Generate into the project Place the generated mobile workflow package
and its files in the current project.

Generate to an external folder Place the generated .zip file containing the ap-
plication and its generated files into a location
outside of the current project. Click Browse to
select the alternate location.

Unwired Server Profile Select the Unwired Server profile with which to
associate the mobile workflow application and
extract the username and password credentials
if you are using static authentication.

Deploy to an Unwired Server Select to deploy the mobile workflow applica-
tion to an Unwired Server.
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Option Description

Deploy Mode The deploy mode is automatically set and can-
not be changed.
• New – generates and deploys the mobile

workflow package and its files for the first
time.

• Update – updates any pre-existing Mobile
Workflow package in-place, preserving as-
sociated assignments.

• Replace – removes any pre-existing Mobile
Workflow package and notifications before
deploying.

Assign workflow to user(s) The mobile workflow must be assigned to a
device user before the mobile workflow is visi-
ble on the user's device. It can be assigned to
multiple users. Separate multiple users with a
comma. Device users must be registered in
Sybase Control Center.

Click Get Users to select device users from the
list.

Note: You must have registered device users in
Sybase Control Center.

Validate controls as soon as the user tries to
change focus away from them

If unselected, validation occurs only when the
screen is saved. If selected, validation occurs as
soon as the control loses focus. If validation
fails, a help element appears and shows the er-
ror message.

3. Click Finish.

A .zip file containing the application and its generated files is created and placed in the
specified location.

Generated Mobile Workflow Files
When you generate the Mobile Workflow package files, some files are generated every time
and others are generated only under certain conditions.

These files are generated every time you generate the Mobile Workflow package:

• manifest.xml

• <workflow_name>.zip

These files are regenerated only if the Generate option is selected in the Mobile Workflow
package generation wizard:
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• <workflow_name>.html

• <workflow_name>_CustomLookAndFeel.html

• <workflow_name>_jQueryMobileLookAndFeel.html

• WorkflowClient.xml

• <workflow_name>.xml

• Resources.js

• Workflow.js

These files are regenerated only if the Generate option is selected and the files do not exist:

• API.js

• Custom.js

• Utils.js

• WorkflowMessage.js

• all *.css files

When you choose to generate the Mobile Workflow package into the current project, the zip
file containing the Mobile Workflow application and its files is placed in the Generated
Workflow folder in the project, for example, C:\Documents and Settings
\<username>\workspace\<Project_Name>\Generated Workflow. They
are shown in the WorkSpace Navigator. This shows the generated file structure for a project
named PurchaseOrder.
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The Generated Workflow\<project_name> folder contains:

• html – this folder includes:

• workflow.html – contains all the screens in the Mobile Workflow application,
each in its own <div> section. This is used on BlackBerry, Android, and iOS platforms
with the Optimize for performance option for the look and feel. On Windows Mobile,
it is used for all looks-and-feels.
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• workflow_customlookandfeel.html – contains all the screens in the Mobile
Workflow application. This is used with the Optimize for appearance look-and-feel
on BlackBerry 5.0

• workflow_jquerymobilelookandfeel.html – contains all the screens in
the Mobile Workflow application. This is used with the Optimize for appearance
look-and-feel on iOS, BlackBerry 6.0, and Android.

• js\Custom.js – edit this file to customize the Mobile Workflow application. Since
you can modify this file, it is generated only once, or when not already present in the
generated files. This ensures that it is not overwritten if you subsequently re-generate
the Mobile Workflow package. Examples of ways you can customize the Mobile
Workflow application include the ability to:
• Manipulate HTML elements.
• Write code that gets called before or after generated behavior is invoked for menu

items.
• Implement custom validation logic.

• <project_name>.zip – contains the mobile workflow application and its files,
including the images, user interface, and controls

Deploying the Mobile Workflow Package to Devices
After generating the Mobile Workflow package and its files and deploying it to Unwired
Server, you must deploy the Mobile Workflow application to the device or simulator.

See the Developer Guide for Mobile Workflow Packages for information about how to
configure devices or simulators for the Mobile Workflow Package.

See Sybase Control Center for Unwired Platform documentation for information about
managing devices, Workflow assignments, and users.

Activating the Workflow
The menu items on a Workflow screen can be either a Submit Workflow (asynchronous) or
Online Request (synchronous) menu item type.

To complete the mobile workflow activation process, the last screen in the mobile workflow
application must have a Submit Workflow menu item. This is necessary for the device and
server-side to activate the mobile workflow for the device.

Mobile workflows are considered to have been processed and/or activated only if they are
closed with a Submit Workflow menu item, and which may, or may not, have a corresponding
mobile business object (MBO) operation tied to it.
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Customizing a Mobile Workflow Package

Use JavaScript code to customize the Mobile Workflow application.

1. Use the Mobile Workflow Package Generation wizard to generate the Mobile Workflow
package and its files.

When the Mobile Workflow package is generated, the Custom.js file is generated if not
already present in the project. The Custom.js file is located in Generated
Workflows\<workflow_project_name>\html\js.

2. Right-click the Custom.js file and select the editor with which to open the file.

3. Add your JavaScript code.

See the Developer Guide for Mobile Workflow Packages for information about the types
of customizations that are supported and the available API methods.

4. Save and close the Custom.js file.

Since the Custom.js file is generated only if it is not already present in the Mobile
Workflow project, this file will not be re-generated if you subsequently re-generate the
Mobile Workflow package, so any modifications you make are preserved.

5. Deploy the Mobile Workflow package to Unwired Server.
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Troubleshoot

Use troubleshooting tips to isolate and resolve common issues.

See Troubleshooting Sybase Unwired Platform for information about troubleshooting issues
with the Eclipse - based user interface or other Sybase Unwired Platform components.
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API Documentation

You can use Sybase Unwired Platform APIs to develop and customize mobile applications,
data handling, error handling, and system functionality programmatically.

• Client Object API – generated business object classes that represent the mobile business
object model built and designed in the Unwired WorkSpace development environment.
Use the API to synchronize and retrieve data and invoke mobile business object
operations. See the developer references, and the Javadocs included in the installation
directory:
• Developer Guide for BlackBerry
• Developer Guide for iOS
• Developer Guide for Windows and Windows Mobile
• Developer Guide for Mobile Workflow Packages

• Unwired Server API – custom Java classes used to implement advanced data handling
features in Unwired Server. See Developer Guide for Unwired Server and the Javadocs
included in the installation directory.

• Administration API – custom Java classes used to integrate Sybase Unwired Platform
system management tools with your enterprise system. See Developer Guide for Unwired
Server Management APIs and the Javadocs included in the installation directory.

Check the Sybase Product Documentation Web site regularly for updates: http://
infocenter.sybase.com/help/index.jsp?topic=/com.sybase.infocenter.pubs.docset-
SUP-2.0.0/doc/html/title.html.
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Glossary: Sybase Unwired Platform

Defines terms for all Sybase Unwired Platform components.

administration perspective – Or administration console. The Unwired Platform
administrative perspective is the Flash-based Web application for managing Unwired Server.
See Sybase Control Center.

administrators – Unwired Platform users to which an administration role has been assigned.
A user with the "SUP Administrator" role is called a "platform administrator" and a user with
the "SUP Domain Administrator" role is called a "domain administrator". These
administration roles must also be assigned SCC administration roles to avoid having to
authenticate to Sybase Control Center in addition to Unwired Server:

• A domain administrator only requires the "sccUserRole" role.
• A platform administrator requires both the "sccAdminRole" and "sccUserRole" roles.

Adobe Flash Player – Adobe Flash Player is required to run Sybase Control Center. Because
of this player, you are required to run Sybase Control Center in a 32-bit browser. Adobe does
not support 64-bit browsers.

Advantage Database Server® – A relational database management system that provides the
messaging database for Sybase Unwired Platform. See messaging database.

Afaria – An enterprise-grade, highly scalable device management solution with advanced
capabilities to ensure that mobile data and devices are up-to-date, reliable, and secure. Afaria
is a seperately licensed product that can extend the Unwired Platform in a mobile enterprise.
Afaria includes a server (Afaria Server), a database (Afaria Database), an administration tool
(Afaria Administrator), and other runtime components, depending on the license you
purchase.

APNS – Apple Push Notification Service.

artifacts – Artifacts can be client-side or automatically generated files; for
example: .xml, .cs, .java, .cab files.

BAPI – Business Application Programming Interface. A BAPI is a set of interfaces to object-
oriented programming methods that enable a programmer to integrate third-party software
into the proprietary R/3 product from SAP®. For specific business tasks such as uploading
transactional data, BAPIs are implemented and stored in the R/3 system as remote function
call (RFC) modules.

BLOB – Binary Large Object. A BLOB is a collection of binary data stored as a single entity
in a database management system. A BLOB may be text, images, audio, or video.

cache – The virtual tables in the consolidated database that store synchronization data.See
CDB.
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cache group – Defined in Unwired WorkSpace, MBOs are grouped and the same cache
refresh policy is applied to their virtual tables (cache) in the CDB.

cache partitions – Partitioning the cache divides it into segments that can be refreshed
individually, which gives better system performance than refreshing the entire cache. Define
cache partitions in Unwired WorkSpace by defining a partition key, which is a load parameter
used by the operation to load data into the cache from the enterprise information system
(EIS).

CDB – Consolidated database. The CDB stores runtime metadata (for Unwired Platform
components) and cache data (for MBOs). See also data tier.

CLI – Command line interface. CLI is the standard term for a command line tool or utility.

client application – See mobile application.

client object API – The client object API is described in the Developer Guide for BlackBerry,
Developer Guide for iOS, and Developer Guide for Windows Mobile.

cluster – Also known as a server farm. Typically clusters are setup as either runtime server
clusters or database clusters (also known as a data tier). Clustering is a method of setting up
redundant Unwired Platform components on your network in order to design a highly scalable
and available system architecture.

cluster database – A data tier component that holds information pertaining to all Unwired
Platform server nodes. Other databases in the Unwired Platform data tier includes the
consolidated, messaging, and monitoring databases.

connection – Includes the configuration details and credentials required to connect to a
database, Web service, or other EIS.

connection pool – A connection pool is a cache of Enterprise Information System (EIS)
connections maintained by Unwired Server, so that the connections can be reused when
Unwired Server receives future requests for data.

connection profile – In Unwired WorkSpace, a connection profile includes the configuration
details and credentials required to connect to an EIS.

context variable – In Unwired WorkSpace, these variables are automatically created when a
developer adds reference(s) to an MBO in a mobile application. One table context variable is
created for each MBO attribute. These variables allow mobile application developers to
specify form fields or operation parameters to use the dynamic value of a selected record of an
MBO during runtime.

data change notification (DCN) – Data change notification (DCN) allows an Enterprise
Information System (EIS) to synchronize its data with the consolidated database through a
push event.

data refresh – A data refresh synchronizes data between the consolidated database and a
back-end EIS so that data in the cache is updated. See also scheduled data refresh.
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data source – In Unwired WorkSpace, a data source is the persistent-storage location for the
data that a mobile business object can access.

data tier – The data tier includes Unwired Server data such as cache, cluster information, and
monitoring. The data tier includes the consolidated database (CDB), cluster, monitoring, and
messaging databases.

deploy – (Unwired Server) Uploading a deployment archive or deployment unit to an
Unwired Server instance. Unwired Server can then make these units accessible to users via a
client application that is installed on a mobile device.

There is a one-to-one mapping between an Unwired WorkSpace project and a server package.
Therefore, all MBOs that you deploy from one project to the same server are deployed to the
same server package.

deployment archive – In Unwired WorkSpace, a deployment archive is created when a
developer creates a package profile and executes the build operation. Building creates an
archive that contains both a deployment unit and a corresponding descriptor file. A
deployment archive can be delivered to an administrator for deployment to a production
version of Unwired Server.

deployment descriptor –  A deployment descriptor is an XML file that describes how a
deployment unit should be deployed to Unwired Server. A deployment descriptor contains
role-mapping and domain-connection information. You can deliver a deployment descriptor
and a deployment unit—jointly called a deployment archive—to an administrator for
deployment to a production version of Unwired Server.

deployment mode – You can set the mode in which a mobile application project or mobile
deployment package is deployed to the target Unwired Server.

deployment profile – A deployment profile is a named instance of predefined server
connections and role mappings that allows developers to automate deployment of multiple
packages from Sybase Unwired WorkSpace to Unwired Server. Role mappings and
connection mappings are transferred from the deployment profile to the deployment unit and
the deployment descriptor.

deployment unit – The Unwired WorkSpace build process generates a deployment unit. It
enables a mobile application to be effectively installed and used in either a preproduction or
production environment. Once generated, a deployment unit allows anyone to deploy all
required objects, logical roles, personalization keys, and server connection information
together, without requiring access to the whole development project. You can deliver a
deployment unit and a deployment descriptor—jointly called a deployment archive—to an
administrator for deployment to a production version of Unwired Server.

development package – A collection of MBOs that you create in Unwired WorkSpace. You
can deploy the contents of a development package on an instance of Unwired Server.

device application – See also mobile application. A device application is a software
application that runs on a mobile device.
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device notification – Replication-based synchronization (RBS) clients receive device
notifications when a data change is detected for any of the MBOs in the synchronization group
to which they are subscribed. Both the change detection interval of the synchronization group
and the notification threshold of the subscription determine how often RBS clients receive
device notifications. Administrators can use subscription templates to specify the notification
threshold for a particular synchronization group.

device user – The user identity tied to a device.

DML – Data manipulation language. DML is a group of computer languages used to retrieve,
insert, delete, and update data in a database.

DMZ – Demilitarized zone; also known as a perimeter network. The DMZ adds a layer of
security to the local area network (LAN), where computers run behind a firewall. Hosts
running in the DMZ cannot send requests directly to hosts running in the LAN.

domain administrator – A user to which the platform administrator assigns domain
administration privileges for one or more domain partitions. The domain administrator has a
restricted view in Sybase Control Center, and only features and domains they can manage are
visible.

domains – Domains provide a logical partitioning of a hosting organization's environment, so
that the organization achieves increased flexibility and granularity of control in multitenant
environments. By default, the Unwired Platform installer creates a single domain named
"default". However the platform administrator can also add more domains as required.

EIS – Enterprise Information System. EIS is a back-end system, such as a database.

Enterprise Explorer – In Unwired WorkSpace, Enterprise Explorer allows you to define data
source and view their metadata (schema objects in case of database, BAPIs for SAP, and so
on).

export –  The Unwired Platform administrator can export the mobile objects, then import
them to another server on the network. That server should meet the requriement needed by the
exported MBO.

hostability – See multitenancy.

IDE – Integrated Development Environment.

JDE – BlackBerry Java Development Environment.

key performance indicator (KPI) – Used by Unwired Platform monitoring. KPIs are
monitoring metrics that are made up for an object, using counters, activities, and time which
jointly for the parameters that show the health of the system. KPIs can use current data or
historical data.

keystore – The location in which encryption keys, digital certificates, and other credentials in
either encrypted or unencrypted keystore file types are stored for Unwired Server runtime
components. See also truststore.
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LDAP – Lightweight Directory Access Protocol.

local business object – Defined in Unwired WorkSpace, local business objects are not bound
to EIS data sources, so cannot be synchronized. Instead, they are objects that are used as local
data store on device.

logical role – Logical roles are defined in mobile business objects, and mapped to physical
roles when the deployment unit that contain the mobile business objects are deployed to
Unwired Server.

matching rules – A rule that triggers a mobile workflow application. Matching rules are used
by the mobile workflow email listener to identify e-mails that match the rules specified by the
administrator. When emails match the rule, Unwired Server sends the e-mail as a mobile
workflow to the device that matches the rule. A matching rule is configured by the
administrator in Sybase Control Center.

MBO – Mobile business object. The fundamental unit of data exchange in Sybase Unwired
Platform. An MBO roughly corresponds to a data set from a back-end data source. The data
can come from a database query, a Web service operation, or SAP. An MBO contains both
concrete implementation-level details and abstract interface-level details. At the
implementation-level, an MBO contains read-only result fields that contain metadata about
the data in the implementation, and parameters that are passed to the back-end data source. At
the interface-level, an MBO contains attributes that map to result fields, which correspond to
client properties. An MBO may have operations, which can also contain parameters that map
to arguments, and which determines how the client passes information to the enterprise
information system (EIS).

You can define relationships between MBOs, and link attributes and parameters in one MBO
to attributes and parameters in another MBO.

MBO attribute – An MBO attribute is a field that can hold data. You can map an MBO
attribute to a result field in a back-end data source; for example, a result field in a database
table.

MBO binding – An MBO binding links MBO attributes and operations to a physical data
source through a connection profile.

MBO operation – An MBO operation can be invoked from a client application to perform a
task; for example, create, delete, or update data in the EIS.

MBO relationship – MBO relationships are analogous to links created by foreign keys in a
relational database. For example, the account MBO has a field called owner_ID that maps to
the ID field in the owner MBO.

Define MBO relationships to facilitate:

• Data synchronization
• EIS data-refresh policy

messaging based synchronization (MBS) – A synchronization method where data is
delivered asynchronously using a secure, reliable messaging protocol. MBS provides fine-

Glossary: Sybase Unwired Platform

Sybase Unwired WorkSpace - Mobile Workflow Package Development 95



grained synchronization (synchronization is provided at the data level—each process
communicates only with the process it depends on), and it is therefore assumed that the device
is always connected and available. See also replication based synchronization.

messaging database – The messaging database allows in-flight messages to be stored until
they can be delivered. This database is used in a messaging based synchronization
environment. The messaging database is part of the Unwired Platform data tier, along with the
consolidated, cluster, and monitoring databases.

mobile application – A Sybase Unwired Platform mobile application is an end-to-end
application, which includes the MBO definition (back-end data connection, attributes,
operations, and relationships), the generated server-side code, and the client-side application
code.

Mobile Application Diagram – The Mobile Application Diagram is the graphical interface
to create and edit MBOs. By dragging and dropping a data source onto the Mobile Application
Diagram, you can create a mobile business object and generate its attribute mappings
automatically.

Mobile Application Project – A collection of MBOs and client-side, design-time artifacts
that make up a mobile application.

mobile workflow packages – Mobile workflow packages use the message-based
synchronization model. The mobile workflow packages are deployed to Unwired Server, and
can be deployed to mobile devices, via the Unwired Platform administrative perspective in
Sybase Control Center.

monitoring – Monitoring is an Unwired Platform feature available in Sybase Control Center
that allows administrators to identify key areas of weakness or periods of high activity in the
particular area they are monitoring. It can be used for system diagnostic or for
troubleshooting. Monitored operations include replication-based synchronization,
messaging-based synchronization, messaging queue, data change notification, device
notification, package, user, and cache activity.

monitoring database – A database that exclusively stores data related to replication and
messaging synchronization, queues status, users, data change notifications, and device
notifications activities. By default, the monitoring database runs in the same data tier as the
consolidated database, messaging database and cluster database.

monitoring profiles – Monitoring profiles specify a monitoring schedule for a particular
group of packages. These profiles let administrators collect granular data on which to base
domain maintenance and configuration decisions.

multitenancy – The ability to host multiple tenants in one Unwired Cluster. Also known as
hostability. See also domains.

node – A host or server computer upon which one or more runtime components have been
installed.
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object query – Defined in Unwired WorkSpace for an MBO and used to filter data that is
downloaded to the device.

openDS –  The default LDAP server that is installed in Developer Edition and is suitable for
authentication and authorization in a development environment.

operation – See MBO operation.

package – A package is a named container for one or more MBOs. On Unwired Server a
package contains MBOs that have been deployed to this instance of the server.

palette – In Unwired WorkSpace, the palette is the graphical interface view from which you
can add MBOs, local business objects, structures, relationships, attributes, and operations to
the Mobile Application Diagram.

parameter – A parameter is a value that is passed to an operation/method. The operation uses
the value to determine the output. When you create an MBO, you can map MBO parameters to
data-source arguments. For example, if a data source looks up population based on a state
abbreviation, the MBO gets the state from the user, then passes it (as a parameter) to the data
source to retrieve the information. Parameters can be:

• Synchronization parameters – synchronize a device application based on the value of the
parameter.

• Load parameters – perform a data refresh based on the value of the parameter.
• Operation parameters – MBO operations contain parameters that map to data source

arguments. Operation parameters determine how the client passes information to the
enterprise information system (EIS).

personalization key – A personalization key allows a mobile device user to specify attribute
values that are used as parameters for selecting data from a data source. Personalization keys
are also used as operation parameters. Personalization keys are set at the package level. There
are three type of personalization keys: Transient, client, server.

They are most useful when they are used in multiple places within a mobile application, or in
multiple mobile applications on the same server. Personalization keys may include attributes
such as name, address, zip code, currency, location, customer list, and so forth.

physical role – A security provider group or role that is used to control access to Unwired
Server resources.

Problems view – In Eclipse, the Problems view displays errors or warnings for the Mobile
Application Project.

provisioning – The process of setting up a mobile device with required runtimes and device
applications. Depending on the synchronization model used and depending on whether or not
the device is also an Afaria client, the files and data required to provision the device varies.

pull synchronization – Pull synchronization is initiated by a remote client to synchronize the
local database with the CDB. On Windows Mobile, pull synchronization is supported only in
RBS applications.
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push synchronization – Push is the server-initiated process of downloading data from
Unwired Server to a remote client, at defined intervals, or based upon the occurrence of an
event.

queue – In-flight messages for a messaging application are saved in a queue. A queue is a list
of pending activities. The server then sends messages to specific destinations in the order that
they appear in the queue. The depth of the queue indicates how many messages are waiting to
be delivered.

relationship –  See MBO relationship.

relay server –  See also Sybase Hosted Relay Service.

replication based synchronization (RBS) – A synchronization method where data is
delivered synchronously using an upload/download pattern. For push-enabled clients, RBS
uses a "poke-pull" synchronization model, where a notification is pushed to the device (poke),
and the device fetches the content (pull), and is assumed that the device is not always
connected to the network and can operate in a disconnected mode and still be productive. For
clients that are not push-enabled, the default synchronization model is pull.See also
messaging based synchronization.

REST web services – Representational State Transfer (REST) is a style of software
architecture for distributed hypermedia systems such as the World Wide Web.

RFC – Remote Function Call. You can use the RFC interface to write applications that
communicate with SAP R/3 applications and databases. An RFC is a standalone function.
Developers use SAP tools to write the Advanced Business Application Programming (ABAP)
code that implements the logic of a function, and then mark it as "remotely callable," which
turns an ABAP function into an RFC.

role –  Roles control access to Sybase Unwired Platform resources. See also logical role and
physical role.

role mapping – Maps a physical (server role) to a logical (Unwired Platform role). Role
mappings can be defined by developers, when they deploy an MBO package to a development
Unwired Server, or by platform or domain administrators when they assign a security
configuration to a domain or deploy a package to a production Unwired Server (and thereby
override the domain-wide settings in the security configuration).

RSOE – Relay Server Outbound Enabler. An RSOE is an application that manages
communication between Unwired Serverand a relay server.

runtime server – An instance of Unwired Server that is running. Typically, a reference to the
runtime server implies a connection to it.

SAP – SAP is one of the EIS types that Unwired Platform supports.

SCC – Sybase Control Center. A Web-based interface that allows you to administer your
installed Sybase products.
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scheduled data refresh – Data is updated in the consolidated database from a back-end EIS,
based on a scheduled data refresh. Typically, data is retrieved from an EIS (for example, SAP)
when a device user synchronizes. However, if an administrator wants the data to be preloaded
for a mobile business object, a data refresh can be scheduled so that data is saved locally in a
cache. By preloading data with a scheduled refresh, the data is available in the information
server when a user synchronizes data from a device. Scheduled data refresh requires that an
administrator define a cache group as "scheduled" (as opposed to "on-demand").

security configuration – Part of the application user and administration user security. A
security configuration determines the scope of user identity, authentication and authorization
checks, and can be assigned to one or more domains by the platform administrator in Sybase
Control Center. A security configuration contains:

• A set of configured security providers (for example LDAP) to which authentication,
authorization, attribution is delegated.

• Role mappings (which can be specified at the domain or package level)

security provider – A security provider and it's repository holds information about the users,
security roles, security policies, and credentials used by some to provide security services to
Unwired Platform. A security provider is part of a security configuration.

security profile – Part of the Unwired Server runtime component security. A security profile
includes encryption metadata to capture certificate alias and the type of authentication used by
server components. By using a security profile, the administrator creates a secured port over
which components communicate.

server connection – The connection between Unwired WorkSpace and a back-end EIS is
called a server connection.

server farm –  See also  cluster. Is the relay server designation for a cluster.

server-initiated synchronization –  See push synchronization.

SOAP –  Simple Object Access Protocol. SOAP is an XML-based protocol that enables
applications to exchange information over HTTP. SOAP is used when Unwired Server
communicates with a Web service.

solution – In Visual Studio, a solution is the high-level local workspace that contains the
projects users create.

Solution Explorer – In Visual Studio, the Solution Explorer pane displays the active projects
in a tree view.

SSO – Single sign-on. SSO is a credential-based authentication mechanism.

statistics – In Unwired Platform, the information collected by the monitoring database to
determine if your system is running as efficiently as possible. Statistics can be current or
historical. Current or historical data can be used to determine system availability or
performance. Performance statistics are known as key performance indicators (KPI).
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Start Page – In Visual Studio, the Start Page is the first page that displays when you launch the
application.

structured data – Structured data can be displayed in a table with columns and labels.

structure object – Defined in Unwired WorkSpace, structures hold complex datatypes, for
example, a table input to a SAP operation.

subscription –  A subscription defines how data is transferred between a user's mobile device
and Unwired Server. Subscriptions are used to notify a device user of data changes, then these
updates are pushed to the user's mobile device.

Sybase Control Center – Sybase Control Center is the Flash-based Web application that
includes a management framework for multiple Sybase server products, including Unwired
Platform. Using the Unwired Platform administration perspective in Sybase Control Center,
you can register clusters to manage Unwired Server, manage domains security configurations,
users, devices, connections and monitor the environment. You can also deploy MBO packages
and manage deployed MBO packages in order to design the synchronization behavior for
those packages. Only use the features and documentation for Unwired Platform. Default
features and documentation in Sybase Control Center do not always apply to the Unwired
Platform use case.

Sybase Hosted Relay Service – The Sybase Hosted Relay Service is a Web-hosted relay
server that enables you to test your Unwired Platform development system.

Sybase Messaging Service – The synchronization service that facilitates communication
with device client applications.

Sybase Unified Agent – Provides runtime services to manage, monitor, and control
distributed Sybase resources. The agent must be running for Sybase Control Center to run.

Sybase Unwired Platform – Sybase Unwired Platform is a development and administrative
platform that enables you to mobilize your enterprise. With Unwired Platform, you can
develop mobile business objects in the Unwired WorkSpace development environment,
connect to structured and unstructured data sources, develop mobile applications, deploy
mobile business objects and applications to Unwired Server, which manages messaging and
data services between your data sources and your mobile devices.

Sybase Unwired WorkSpace – Sybase Unwired Platform includes Unwired WorkSpace,
which is a development tool for creating mobile business objects and mobile applications.

synchronization group – Defined in Unwired WorkSpace, a synchronization group is a
collection of MBOs that are synchronized at the same time.

synchronization parameter – A synchronization parameter is an MBO attribute used to filter
and synchronize data between a mobile device and Unwired Server.

synchronization phase – For replication based synchronization packages, the phase can be
an upload event (from device to the consolidated database) or download event (from the
consolidated database to the device).
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synchronize –  See also data refresh. Synchronization is the process by which data
consistency and population is achieved between remote disconnected clients and Unwired
Server.

truststore – The location in which certificate authority (CA) signing certificates are stored.
See also keystore.

undeploy – Running undeploy removes a domain package from an Unwired Server.

Unwired Server – The application server included with the Sybase Unwired Platform
product that manages mobile applications, back-end EIS synchronization, communication,
security, transactions, and scheduling.

user –  Sybase Control Center displays the mobile-device users who are registered with the
server.

Visual SQL – A graphical user interface tool that you can use to build SQL queries.

Visual Studio – Microsoft Visual Studio is an integrated development environment product
that you can use to develop device applications from generated Unwired WorkSpace code.

Welcome page – In Eclipse, the first set of pages that display when you launch the application.

workspace – In Eclipse, a workspace is the directory on your local machine where Eclipse
stores the projects that you create.

WorkSpace Navigator – In Eclipse, the tree view that displays your mobile application
projects.

WSDL file – Web Service Definition Language file. The file that describes the Web service
interface that allows clients to communicate with the Web service. When you create a Web
service connection for a mobile business object, you enter the location of a WSDL file in the
URL.
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